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Before you begin

4is learner guide is based on the unit of competency BSBITU313 Design and produce digital 
text documents, Release 1. Your trainer or training organisation must give you information 
about this unit of competency as part of your training program. You can access the unit of 
competency and assessment requirements at: www.training.gov.au.

How to work through this learner guide
4is learner guide contains a number of features that will assist you in your learning. Your 
trainer will advise which parts of the learner guide you need to read, and which practice 
tasks and learning checkpoints you need to complete. 4e features of this learner guide are 
detailed in the following table.

Icon Feature of the 

learner guide

How you can use each feature 

Learning content Read each topic in this learner guide. If you come across 

content that is confusing, make a note and discuss it with 

your trainer. Your trainer is in the best position to offer 

assistance. It is very important that you take on some of 

the responsibility for the learning you will undertake.

Examples These highlight learning points and provide realistic 

examples of workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills 

and knowledge into action. Your trainer will tell you which 

practice tasks to complete.

Video clips Where QR codes appear, you can use a smartphone or 

other device to access video clips relating to the content. 

For information about how to download a QR reader app or 

accessing video on your device, please visit our website: 

www.aspirelr.com.au/help

Summaries Key learning points are provided at the end of each topic.

Learning 

checkpoints

There is a learning checkpoint at the end of each topic. Your 

trainer will tell you which learning checkpoints to complete. 

These checkpoints give you an opportunity to check your 

progress and apply the skills and knowledge you have 

learnt.
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Foundation skills
As you complete learning using this guide, you will be developing the foundation skills 
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN) 
skills and the employability skills required for participation in modern workplaces and 
contemporary life.

4e following table outlines speci=c foundation skills noted for your learning in this 
learner guide. 

Foundation skill area Foundation skill description

Reading  • Recognises and interprets textual information from a range of 

sources to determine and adhere to requirements

Writing  • Develops documents using required format, accurate spelling 

and grammar and terminology speci�c to requirements

 • Organises content to support purpose and audience of material 

using clear and logical language

Oral communication  • Uses speci�c and direct language, and listening and questioning 

techniques to clarify requirements  

Navigate the world of work  • Recognises and follows explicit and implicit protocols and meets 

expectations associated with own role

Interact with others  • Collaborates with others to achieve joint outcomes

Get the work done  • Uses advanced features within digital applications to address 

routine and complex work tasks
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Topic 1 
Prepare to produce documents

Careful preparation is integral to the level of success of any activity. Planning, 

research and gathering tools together will ensure a timely and successful 

outcome.

Preparation begins with a safe work environment and knowledge of good work practices. 
4is involves identifying and clarifying the purpose, audience and presentation 
requirements of a document to ensure consistency of style and language.

In this topic you will learn how to:

1A Use safe and e�cient work practices

1B Identify the purpose, audience and presentation requirements of a document

1C Ensure consistency of style and language
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Workplace safety is everyone’s responsibility. 

Both employers and employees must make an active 
contribution to ensuring their workplace is safe. 
Hazards need to be identi=ed and risks assessed to 
reduce the risk of injury in the workplace. If you are 
working at a computer for an extended period of time 
each day, your workstation must be comfortable and 
designed to help you carry out your tasks e�ciently. 
You will need to organise your work so that you are 
not doing a repetitive task for a long time. You should 
also take regular breaks to stand up and stretch. 

Another consideration is to use resource 
conservation techniques to minimise waste. Most 
organisations require staA to follow resource-saving 
procedures such as turning oA lights in unused rooms and recycling paper. You need to be 
aware of and follow conservation eAorts made by your organisation.

Health and safety legislative requirements

You must work in line with legislative requirements, regulations, Australian and 

industry standards, and the relevant codes of practice.

All health and safety legislation requires employers to provide a safe workplace and 
adequate training and supervision, while controlling workplace hazards and risks. 

Health and safety legislation outlines legal requirements such as:

 • managing risks to health and safety

 • promoting and maintaining the health, safety and welfare of people at work

 • protecting people at work from injury and illness, including psychological injury

 • protecting the health and safety of the public in the workplace

 • consulting workers and encouraging them to maintain health and safety

 • providing rehabilitation and recovery for injured workers.

Health and safety policies and procedures

Health and safety policies and procedures are documents that ensure all 

employees work safely and e"ectively. 

All workplaces in Australia are required to have a health and safety policy in place that 
describes the organisation’s and employees’ responsibility for maintaining health and safety. 
4e policy should include the organisation’s goals and objectives regarding health and 
safety, and can help you ful=l your duty of care as an employee.

4e following information relates to working in an o�ce and using a workstation, and 
should be contained in an organisation’s health and safety procedures.

1A Use safe and e-cient work practices
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Health and safety procedures outline:

 • workstation ergonomics

 • standard safety precautions and housekeeping

 • safe handling of hazardous substances, e.g. cleaning products or printer inks

 • emergency and �re drills

 • hazard identi�cation and risk control

 • manual handling, e.g. lifting, reaching and repetitive work tasks 

 • emergency contact numbers, including local doctors and hospitals

 • location of �rst-aid equipment 

 • details of �rst-aid of�cers.

Control risks associated with hazardous manual tasks

It is a legal requirement for the employer and workers to address the risks 

associated with hazardous manual tasks in the workplace. 

A person conducting a business or undertaking (PCBU) must manage risks to health and 
safety associated with undertaking a hazardous manual task, including risks of developing a 
musculoskeletal disorder (MSD). 

Health and safety regulations and the Code of Practice for Hazardous Manual Tasks outline 
speci=c requirements for hazardous manual tasks that must be addressed, including:

• identifying hazardous manual tasks

• assessing the risks

• controlling the risks

• reviewing the control measures.

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own 
set of procedures to manage the risk of MSDs.

To determine which control measures to implement, the PCBU must consider the 

following:

 • postures, movements, forces and vibration relating to the hazardous manual task

 • the duration and frequency of the hazardous manual task

 • work conditions that may affect the hazardous manual task or the worker 

 • the design of the work area and layout of the workplace

 • the systems of work used

 • the nature, size, weight or number of people or things involved in carrying out the 

hazardous manual task.
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Musculoskeletal disorders

The repetitive movements and sustained body position associated with 

entering data into a computer is regarded as a hazardous manual task and puts 

the operator at risk of developing an MSD. 

MSDs come about in two main ways:

• gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through 
repeated or continuous use of the same body parts, including static body positions

• sudden damage caused by strenuous activity or unexpected movements, such as when 
loads being handled suddenly move or change position.

MSDs may include conditions such as: 

 • sprains and strains of muscles, ligaments and tendons

 • back injuries, including damage to the muscles, tendons, ligaments, spinal discs, 

nerves, joints and bones

 • joint and bone injuries or degeneration, including injuries to the shoulder, elbow, 

wrist, hip, knee, ankle, hands and feet

 • nerve injuries or compression, e.g. carpal tunnel syndrome

 • muscular and vascular disorders as a result of hand–arm vibration

 • soft tissue hernias

 • chronic pain.

Standard precautions

Your organisation may require you to use standard precautions, particularly 

work practices related to the prevention of repetitive strain injuries (RSIs). 

4ese include ergonomic practices, workstation design, enforced 
breaks and regular exercise routines, such as stretching, rolling 
the shoulders and shaking arms.

Workers in an o�ce are expected to follow standard precautions 
when using a workstation, particularly at a sit-down desk. 
Research on sitting has demonstrated that other precautions 
also need to be considered to help prevent injuries, such using 
standing workstations and alternating the mouse from one side 
to the other. It is important that you carefully follow any standard 
precautions that are prescribed for your workplace.

Equipment and systems safety checks

An important part of your daily work routine is to check the various systems 

and equipment you use during the day to make sure they are in good working 

order. 

Your organisational policies and procedures should include steps to follow. You may need 
to perform this procedure at the start of your work day or at speci=ed intervals throughout 
the day.
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Workstation safety procedure/checklist:

 • Ensure your seat is positioned in front of your computer and that you can reach 

your keyboard comfortably.

 • Position the monitor out of direct sunlight and at the correct height. 

 • Ensure the environment is dust-free as dust can affect the monitor or the 

computer’s central processing unit (CPU).

 • Ensure cables are secured so no one trips over them.

 • Use blinds and window coverings to reduce glare and heat at your workstation.

 • Ensure temperatures do not exceed 26°C and that humidity is between 40 and 60 

per cent.

Ergonomics

The aim of ergonomics is to reduce the risk of accidents, injury and illness by 

applying safe work practices. 

Ergonomics is about creating comfortable 
working conditions by adapting 
workstations, tools and equipment to 
an individual worker’s needs. It also 
improves performance and productivity 
in the workplace. Ergonomics covers all 
aspects of working, from physical stresses 
such as sitting at a workstation all day to 
environmental factors such as noise, air 
conditioning and lighting.

When your posture is poor, you may suAer 
from aches and pains. Spending a long 
time in the same position can put stress 
on your body and this can be made worse 
if you are in an uncomfortable or poorly supported position. 4ese symptoms may be very 
slight at =rst, but if you continue to have poor posture your symptoms may get worse and 
become intolerable. 4ey may result in cumulative stress given the constant strain on your 
muscles, nerves or tendons. 

When setting up your workstation, make sure your posture will not cause you pain or 
discomfort. 4e equipment you use needs to be adjusted to suit your body shape and size, 
and the tasks you are doing.

Ergonomic workstation design

How your workstation is designed can a"ect your health and wellbeing. 

Several physical problems can result from poor workstation design; for example, lower back 
strain may result from sitting in a chair that does not support your back. Some features of 
the workstation may vary depending on the type of work being performed. 
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Below are some guidelines for setting up an ergonomic workstation. 

Chair

Adjust the seat height to suit your furniture and equipment. Ensure 

that your feet are �at on the �oor, your thighs are horizontal and 

your lower legs are vertical. If possible, use a chair with a �ve-

castor base.

Adjust the backrest by raising it to the maximum height and then 

lowering it until it �ts the curve of your lower back. If this is not 

comfortable, lower it another couple of centimetres. Continue this 

until it reaches a comfortable position. 

The backrest should support your lower back, and may also be 

adjusted backwards and forwards. When seated in your usual 

working position, move the backrest until it has a gentle pressure 

on your lower back. Make sure there is at least 2cm of space 

between the front of the seat and the back of your knees. Armrests 

should be positioned so that they do not interfere with carrying out 

your work tasks.

Desk

Keep your head erect when seated at your desk, and ensure that 

the surface of the desk is just below elbow height. 

If your desk is not height-adjustable, try to raise your chair so you 

are sitting at the correct height and use a footrest, if necessary, 

to make up the difference. Ensure there is clearance between the 

lower edge of the desk and your legs, and between the front edge 

of your seat and your desk.

If your desk is too low, you may be able to extend the legs. You 

should have plenty of leg space underneath your desk. Don’t 

clutter the space with bags and bins, as your legs may become 

cramped and your posture may become twisted. 

Position any equipment or materials you use so that you can reach 

them easily without twisting. For example, place frequently used 

stationery in the top desk drawer, and ensure your keyboard and 

monitor sit directly in front of you to avoid having to twist your body.

Keyboard

The angle of your keyboard can be adjusted to suit you by moving 

the supports underneath it. Place the keyboard as close as 

possible to the front of your desk. Have your upper arms hanging 

freely. Your forearms should be approximately horizontal.

While typing it is best not to rest your wrists, as they should not 

be bent up, down or to the side. The knuckle, wrist and top of the 

forearm should form a straight line. Wrist supports give you a place 

to rest your hands only when pausing from typing, not while you 

are typing. Do not pound the keys; instead, use a light touch. Leave 

enough room on your desk to put the keyboard out of the way when 

you are not using it.

Don’t place documents between yourself and the keyboard, 

as stretching will eventually cause muscle strain in your arms, 

shoulders and neck. 
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Mouse

Place the mouse and mouse pad directly beside your keyboard on 

the side you prefer. If you use the mouse frequently, you could try 

to alternate sides. You will be surprised at how easy this becomes 

with practice. Your wrist should be straight and the desk should 

support the weight of your wrist, not your arm. Try to keep your 

wrist �at and rest your �ngers on the mouse between clicks. Hold 

the mouse lightly. Don’t hold onto the mouse when you are not 

using it.

Monitor

Once you have adjusted your chair and desk, you can position 

your monitor. Adjust it so that the top of the monitor is level with or 

slightly lower than your eyes. If you can’t adjust the monitor to the 

correct height, place it on a platform.

The viewing distance should be between 40cm and 70cm. The 

screen angle should be adjustable between 85 and 125 degrees. 

It is best to position the screen so that you can clearly read the text 

without having to lean forward, twist your neck or look upwards. 

A relaxed viewing angle is approximately 35 degrees. Place a 

document holder beneath or beside the monitor at the same 

viewing distance as the screen.

Also take surrounding factors into consideration when positioning 

your screen, such as re�ection, glare and shadow. You may need to 

use an anti-glare �lter.

Desktop layout

Items on your desk, including equipment and resources, should be arranged so 

they are within easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, 
where your hands operate most of the time

• the maximum reach zone – items are further 
away, but still close enough to reach comfortably

• the outer reach zone – where you may have to 
bend forward or stand to reach items.

Make sure your desk is organised so that frequently 
used objects, such as your keyboard, are close to you. 
Objects that are used less frequently, such as your 
phone, should be out of the way but still within easy 
reach. Other resources that are rarely used, such as 
in- and out-trays, should be in the outer reach zone.

4e following outlines some devices that can help you maintain a good posture at your 
workstation.
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A footrest 

may be 

necessary 

if you 

can’t place 

your feet 

comfortably on 

the �oor. Footrests 

allow your feet to rest 

at the correct height and 

on a tilting angle, which prevents 

strain on the lower back.

If you 

use a 

telephone 

for long 

periods of 

time, it is a 

good idea to 

use a headset. A 

headset will keep your 

neck straight and your 

arms free. Headsets prevent you 

from bending your neck to support the 

telephone handpiece.

Angle boards allow the user to maintain 

the correct posture when reading by 

reducing the angle between the work 

surface and the user. These supports 

can be adjusted to a suitable height and 

angle, and enable comfortable reading 

with the neck correctly positioned. Try to 

keep your neck as straight as possible 

when you are reading.

Document holders are designed to 

hold papers and reference material in 

a convenient position for viewing. Place 

your document holder in the correct 

position. If it is below the screen or too 

far off to the side, each time your eyes 

look from one source to the other, your 

pupils have to adjust. Doing this for 

long periods of time can cause 

headaches and eyestrain. 

Place the document 

holder at a similar 

level, angle and 

distance as 

the screen to 

avoid having 

to shift your 

eye focus.
D
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H
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Setting up a home o-ce

Communication technology and organisational policies to maintain a 

sustainable work–life balance have created opportunities for more .exible 

working arrangements. 

4is means that more employees are working from home o�ces or in other remote 
locations. Many bene=ts can be derived from Iexible working arrangements for employers 
and employees, but there is still a responsibility for all parties to make sure that home and 
remote o�ces use ergonomic practices and follow health and safety requirements.
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Hot desking

Hot desking refers to a system where workstations are not assigned to suit an 

individual worker, but may be used by multiple workers during di"erent periods 

of time. 

4e motivation behind hot desking is primarily the cost savings achieved by setting 
up fewer workstations in workplaces where not all the workers are in the o�ce at the 
same time. 

Another common adaptation of hot desking is where workstations are assigned to 
individual workers, but need to be readily available for other workers to access based on 
daily work requirements, such as a group of people coming together to work on a speci=c 
project.

Considerations with hot desking:

 • It is common for workers to want their own space. Consequently, they may choose 

one location and stick to it.

 • It can take extra time each day to set up a workstation for each individual to 

maintain good ergonomics and work ef�ciency. 

 • Personal hygiene needs to be maintained to prevent the spread of germs on items 

such as keyboards and mouses.

 • Workstations need to be tidied appropriately in readiness for the next user. 

The bene1ts of standing desks

Sitting at a desk for long periods of time has many negative health e"ects. 

4ese can be overcome by using standing desks. Standing provides a greater opportunity for 
your body to move and adjust, and involves more muscular activity than sitting. 

Some studies have shown that the negative eAects of prolonged sitting cannot be 
counteracted by regular exercise alone. 4e only way to eliminate the problem is to avoid 
sitting as much as possible. 

Some of the health bene=ts of standing include:

• alleviating back pain and other repetitive strain injuries by greater use of core back 
muscles to support the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood clots, which 
can be caused by prolonged sitting.

It is recommended that you start using a standing desk gradually by alternating between 
sitting and standing. Using a standing desk for hours on end requires your body to adapt. 
You may experience sore feet, tired legs and fatigue at =rst. Wear comfortable shoes and use 
an anti-fatigue Ioor mat to help counteract this.

Ensure you have an ergonomically designed standing desk so that you maintain correct 
posture while working. 
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Standing desk recommendations

 • Position arms at 90 degrees when standing.

 • Place the computer screen at eye level and tilt it slightly upwards.

 • Place the computer monitor at least arm’s length away.

 • Keep your back straight and avoid leaning on the desk.

Monitor and adjust lighting

Good lighting is essential for a safe and hazard-free workplace. 

You need to see things clearly in order to work eAectively. Simply shi0ing the screen angle, 
adjusting blinds, altering the brightness settings on the screen and using desk lamps can 
reduce risks associated with poor lighting. Use natural sunlight rather than arti=cial lights 
if possible. If not, keep bulbs and =xtures clean, focus light on your task and use Iuorescent 
lights to minimise eye strain and headaches. 

The following are hazards associated with poor lighting:

 • Glare – A computer screen positioned in front of a bright window can be dif�cult to 

see.

 • Flickering lights – A �uorescent light may malfunction, causing annoyance, irritation 

and even nausea.

 • Inadequate lighting – Reading in dim light can cause eyestrain.

 • Shadows – Shadows shifting across your work area can cause you to sit with bad 

posture in order to view your work.

Managing noise in the workplace

Noise can include any ongoing, loud or disturbing sound. 

Excessive noise around machinery or equipment can cause permanent hearing loss. 
Noise is a problem if it disturbs or distracts employees, causes stress or interferes with 
communication or work.

Many o�ces are open-plan, o0en with employees seated close to each other and divided 
by partitions at chest or head height. 4ink about noise levels when you set up your 
workstation. It should be possible for people in open-plan o�ces to have some privacy when 
they are on the phone and carrying out their day-to-day tasks.

Noise in the o�ce can come from:

• machines and equipment, such as photocopiers, scanners, paper shredders, phones and 
printers

• outside tra�c and road works

• people talking to each other or on the phone.
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Noise can also be a problem in other workplaces, such as on factory Ioors and at 
construction sites. You may have to wear ear protection if you are required to work in an 
excessively noisy environment.

4ere are many ways that noise can be controlled in the workplace. Examples include: 

• Noisy machines can be put in a separate room or area. 

• Sound-absorbent materials such as carpet and partitions can be installed or arranged to 
deIect and absorb noise. 

• 4e volume level on your speakers can be adjusted.

Remember that noise is only a hazard when it is stopping you from working productively, 
comfortably or safely. Many people prefer to work with low levels of noise rather than 
complete silence.

Monitoring and adjusting air conditioners

Air-conditioning systems may cause hazards due to poor-quality air or 

inadequate temperatures.

Air-conditioned o�ces do not have fresh air from open windows. 4is can cause problems 
for some people. 4e air quality may need to be adjusted by allowing more fresh air inside or 
by improved ventilation systems.

Additionally, o�ce workers frequently complain of being too hot or too cold. If a person’s 
desk is near an air-conditioning outlet, the area around their desk can be much colder 
than elsewhere in the o�ce. 4ey can also suAer from dry and itchy eyes. Report such 
hazards to the relevant person. 4is situation can usually be corrected by adjusting air-
conditioning Iow.

Vary your activities

Make sure you plan your daily tasks so that you aren’t doing repetitive work for 

long periods of time.

Having a well-planned workstation and comfortable 
surroundings is pointless if you don’t organise your 
work in a way that prevents discomfort or pain. 

Your work role may involve several diAerent tasks. 
Some tasks may be repetitive, such as typing up 
reports or entering data. If you are able to vary the 
tasks you carry out each day, this will help to prevent 
repetitive actions that cause stress to your body. 
For example, if you have to enter a lot of data, break 
up the repetitive nature of the task by discussing a 
project with a colleague, doing some research online 
or doing another work task. 

You should also take regular breaks. Employers are 
required to allow employees to take rest periods throughout the day, including tea and lunch 
breaks, to reduce stress and fatigue.
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Take exercise breaks

Using computers for too long without breaks has been associated with back 

and neck pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage your colleagues to try 
them too. Make sure you are relaxed and stretch gently, without overstretching. Stop if 
you feel any pain or discomfort, and remember to exercise both sides of your body. Most 
importantly, breathe deeply and evenly throughout the stretch.

 • Neck: Turn your head gently to look over your right shoulder. Hold for 10 seconds. 

Now roll your head forward to look over your left shoulder and hold for 10 seconds. 

Repeat several times.

 • Shoulders: Sitting with a straight back and neck, roll your shoulders forward, then 

back. Repeat several times.

 • Wrists, hands and arms: Interlacing �ngers, turn your palms upwards. Now lift your 

arms over your head and stretch, leaning gently to the left and then to the right. 

Repeat movement several times.

 • Upper and lower back: In a standing position, place your hands in the small of your 

back. Gently arch your back and hold for 10 seconds. Repeat when needed.

 • Shoulders and arms: Stretch your arms above your head, cradle your elbow with your 

hand and gently pull your elbow behind your head. Repeat on the other side, holding 

the stretch for 10 seconds.

 • Eyes: Every 20 minutes, look away from the screen. Focus on a distant object (more 

than three metres away).

Practise conservation techniques

Conserving resources at work not only bene4ts the organisation by reducing 

costs, but also the planet by reducing greenhouse gases and the amount of 

waste sent to land4ll. 

Most organisations have policies and procedures for conserving resources. You can =nd out 
what these are by reading your workplace manual, or by asking your manager or colleagues.

Watch a video demonstration of the above 

exercises here.

v1323
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4e following outlines ways to conserve resources at work.

Minimise paper wastage

Policies for reducing paper wastage include:

 • using both sides of the paper when printing and photocopying

 • recycling non-con�dential waste paper 

 • reducing the volume of printing where possible, such as working with documents on-

screen or scanning to an email

 • reusing paper by using blank sides for rough drafts 

 • using recycled paper or paper from plantation timber for printed documents.

Reduce energy use

Policies and procedures for saving energy include:

 • providing training programs on smart energy practices so that employees can 

practise energy ef�ciency

 • turning off lights and equipment when not in use 

 • keeping air conditioners at 18–20°C in winter and 24–27°C in summer

 • using power-saving functions on devices such as computers and tablets when not in use.

Practice task 1

Question 1 

Here is a checklist to follow when setting up your workstation. Go through the points that are 

relevant to you and make any necessary adjustments to your work area. You may need another 

person to help you and check your posture. If you are not able to tick some of the checkpoints, 

discuss making alterations to your workstation with your manager.

Chair

Is the seat height-adjustable?

Is it high enough to allow you to sit comfortably at the keyboard?

Is it stable?

Does it swivel?

Is the height of the backrest adjustable and does it tilt backwards and forwards?

If it has arms, can you still get close enough to the desk and swivel the chair?

Are your feet �at on the �oor or are you using a footrest?

Are you sitting up straight with the backrest �rm against your back?
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Desk

Is it large enough to allow the screen and keyboard to be correctly positioned?

Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

Is it high enough to allow your thighs to �t comfortably underneath?

Keyboard

Can it be tilted to allow you to adjust it?

Are the symbols on the keys clear and easy to see?

Is there suf�cient space in front of it to allow you to correctly position your arms?

Monitor

Does the monitor have easily adjustable brightness and contrast controls?

Is the image on the monitor stable and �icker-free?

Are there adjustment mechanisms to allow the monitor to be tilted, swivelled or raised to 

avoid glare and re�ections, and help you keep a natural and relaxed posture?

Are you sitting far away enough from it for comfort?

Question 2 

Give two examples of health and safety requirements you should follow before starting work at 

your computer desk.

Question 3 

Give two examples of a health and safety requirement you should follow when producing a large 

document that you know will take many hours of keyboarding to complete.
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Every organisation has an image it wishes to present to the public. A document 

can provide an opportunity for an organisation to promote itself. 

4erefore, it is essential that the choice of document, 
as well as its presentation and content, represents the 
organisation in the best possible way.

When designing and producing text documents, it is 
important to ensure they reIect your organisation’s 
corporate image and style. Your organisation should 
have a style guide you can refer to for instructions on 
format and =nal presentation. You will need to clarify 
task requirements so you can produce the most 
appropriate document. Knowing where to locate 
information about document design and structure 
and how to apply the information is a fundamental 
skill you will need every day in your job.

Communication with colleagues is also essential. When tasks are shared and you contribute 
to a common outcome, the way you communicate with your colleagues and interpret their 
instructions is critical. 

Points to determine before proceeding when creating a document:

 • Is this information for internal or external distribution?

 • Is a letter or memo the best way to distribute this information?

 • What is the most ef�cient way of distributing this information?

 • What document format would present the required message to the best advantage?

Identify a document’s purpose

The style and type of document you need to create will be determined by its 

purpose, such as an agenda for a meeting or information for clients about 

organisational news and events. 

Always clarify the purpose of the document because this will determine the way it is 
planned and designed. For example, if the document’s purpose is to provide detailed 
information about the progress of a project, you may need to fact-check information from 
colleagues before putting the document together. 

4e purpose could be to convey:

• new products

• public holiday arrangements

• sales or special events

• notices to other organisations

• new policies

• =nancial information

• your organisation’s annual activity

• new or updated legislation.

1B Identify the purpose, audience and 
presentation requirements of a document
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Identify a document’s audience

A document’s purpose and presentation is in.uenced by its target audience. 

Consider the information needs of the audience and how detailed the information should 
be. For example, an internal document may be less formal than an external document; 
alternatively, a formal style may be appropriate for managers and a less complicated style for 
customers. 

Discussion about the document’s purpose, appearance, target audience, other users and 
organisational standards is important as it oAers the document designer a vision of what 
is required. No matter who the audience is, a general rule would be to make sure the 
document is succinct with enough detail to meet the brief. 

Audiences may be:

 • clients

 • staff

 • customers

 • business associates

 • suppliers

 • colleagues

 • industry organisations.

Identify the presentation requirements for a document

Once the document’s purpose has been established and the audience de4ned, 

you will need to decide what type of document is required and how it should be 

presented.

Most organisations have developed policies and procedures for how they would like 
documents to be presented. How you present your document will enhance the audience’s 
ability to understand it; for example, you may need to present numerical data in tables 
or charts. Before starting to produce the document, check if there is a template available. 
Your organisation may require you to use templates for various document types, such as 
presentations, memos, agendas, meeting minutes and reports.

Digital documents used by organisations include:

 • memos sharing information 

 • agendas and minutes for meetings

 • annual reports or research reports 

 • promotional material, including �yers, brochures and calendars 

 • simple or multi-page letters

 • brie�ng papers

 • letters to customers or clients

 • mail-merge documents, such as labels, reports, schedules and tables

 • envelopes with addresses

 • presentation slides.
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Letters

Letters are a common communication tool used to pass on a wide range of 

information. 

Letters are o0en used as a formal method of contacting customers or other businesses. A 
well-written letter will give a professional impression of the organisation.

Some common types of letters are provided below.

Acknowledgments

For example, to con�rm that your organisation has received something, or to 

acknowledge a job application.

Complaints and claims

For example, to inform a supplier they have delivered faulty goods.

Adjustments

For example, a reply to a customer who has complained to let them know their problem 

has been resolved.

Covering letters

For example, to accompany what is being sent in a parcel of goods, or as an attachment 

to a document.

Follow-up letters

For example, to con�rm something that has been agreed to verbally.

Inquiries

For example, for information about who will be at a meeting, or to �nd out the availability 

of a conference centre.

Requests

For example, for quotations for a service, or to ascertain prices.
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The structure of business letters

Business letters often follow a de4nitive style, which you may need to be 

familiar with.

Most organisations use what is called a fully blocked layout. 4is has the entire letter 
(including the address) aligned on the le0 side and has single spacing between lines and a 
double space between paragraphs. Sometimes the punctuation is open, which means there 
is no punctuation outside the wording (body) of the letter itself. Some organisations use a 
mixed punctuation style, which means they place a comma a0er the greeting and the close.

Business letters will typically display the following elements.

Date

The convention in Australia is to write the day, month and year; for example, 12 May 

2018.

Sender’s address

The address of the business is usually displayed, which may be part of the company 

letterhead.

Name, title and address of the recipient

If you do not know the person’s title, you should try to �nd out. If you are unsure how a 

woman prefers to be addressed, use Ms.

Greeting

Sometimes called the salutation. This is usually ‘Dear’ followed by the same title and 

surname as used in the inside address. If you do not know the recipient’s name or 

gender, you can use ‘Dear Sir/Madam’.

Body

This is the main content of the letter.

Closing

In a business letter the formal closing is ‘Yours sincerely’ if you know the name of the 

person you are writing to, or ‘Yours faithfully’ if you do not.

Signature and identi�cation

This is usually six lines below the close. After the signature is the sender’s name and 

position in the organisation (the position is usually in bold).
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Here is an example of a business letter

JC Jackson Photography

“Capturing moments for eternity”

Shop 21, Fairholme Plaza

MAROOCHYDORE 

QLD R558

Ph: 07 5443 4237 

Email: inquiries@

jcjackson.net.au

Web: www.jcjackson.net.au

20 May 2018

Mr Donald Turner

Queensland Business Awards

21 Stephens Street

Chernside QLD 4032

Dear Mr Turner,

Thank you for the opportunity to submit the quotation for 
the provision of photographic services for the Queensland 
Business Awards.

The quotation includes a breakdown of prices for services 
as discussed at our meeting last week. Separate charges are 
included for the following:

• hourly charge for photographer

• proofs

• individual reprints

• bulk reprints

• enlargements.

If you require any additional information, please do not 
hesitate to contact me. I look forward to speaking with 
you soon.

Yours sincerely,

Joshua Jackson

Manager

Organisation’s 

letterhead

Date

Recipient’s name and 

address

Greeting

Body (content)

Closing

Signature
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Memos

A memo is an internal document that is sent to sta" in an organisation. 

Memos can be sent to one person or several people. Memos should contain the following 
information: 

• memo header

• date

• recipients

• sender’s name

• subject

• main body

• signature.

Promotional materials

Promotional materials are used to promote an organisation and its products 

and services. 

4ese include Iyers, brochures, invitations, business cards and price lists.

Information that may be printed on promotional materials includes:

• an organisation’s name

• logo

• telephone number

• street or postal address

• email address

• website.

Here is some information on the diAerent types of promotional materials. 

Flyers

A �yer is a piece of paper distributed to a wide audience to 

advertise an event, product or service. An organisation may 

produce a �yer to post to clients to inform them of a special offer, 

or to let staff know about an upcoming event. The purpose of a 

�yer is to attract people’s attention and interest them in the �yer’s 

subject.

Brochures

A brochure is a piece of promotional material distributed by 

an organisation to provide information about its products and 

services. Brochures may also offer in-depth information about a 

speci�c product or range of products. Brochures can be one page 

or multiple pages and are often printed in colour with a glossy 

�nish.
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Forms and tables

Forms are used by organisations to record and collect information. 

Forms can be one page or multiple pages and can be created to 

meet any need. Common forms include customer feedback forms, 

order forms and time sheets. Word-processing software has a 

range of features you can use to create forms, but one of the more 

popular methods is to use a table or a series of tables.

Here is an example of a tri-fold brochure.

When you create tri-fold brochures you need to lay it out from back to front so that when it 
is printed double-sided the content is displayed correctly. If you open a brochure template in 
Word, you will see this is how it is laid out.
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Here is an example of a customer order form. Four tables were used to create this form. 

Creating a form 

Tables allow information to be displayed or collected in a clearly de4ned space.

When using tables to display data, the use of headings for the rows or columns makes it easy 
for the reader to understand the data.

Have you ever tried to =ll in a form where the lines were too close together and the spaces 
provided were insu�cient for the required responses? 4is is something you must be aware 
of when creating tables to ful=l that function.
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4e table below demonstrates how eAective tables can be for presenting and clarifying data. 

Number of passenger vehicle registrations

Year Victoria New South Wales

2013  3,446,548  3,877,515 

2017  3,750,484  4,217,400 

2018  3,838,133  4,277,481 

Imagine if the information was presented in sentence form. 4is is exactly the same 
information, but is much harder to interpret:

Victoria had 3,446,548 new vehicle registrations in 2013, 3,750,484 in 2017 and 3,838,133 in 
2018, while New South Wales had 3,877,515 in 2013, 4,217,400 in 2017 and 4,277,481 in 2018.

Reports

A report is a formal document that may be used for a range of purposes. 

A report may be written about the progress of an existing project, to detail the feasibility of 
a future project or to summarise the =ndings of research that has been undertaken. Writing 
a report is a way of communicating organisational information to a wide audience.

Reports o0en include a lot of information that may need to be collected from multiple 
people within or outside of an organisation. For example, the progress of multiple teams 
may need to be compiled in a single report.

Formal reports

A variety of formal reports are produced 

by large organisations. These include 

annual reports, �nancial reports, 

feasibility reports and project reports. 

Formal reports can be hundreds of pages 

long and often use complex numbering 

systems so that people reading the 

report can easily locate information.

The structure of formal reports usually 

includes the following elements:

 • Title page

 • Table of contents

 • List of tables or graphs 

 • Summary of key points (executive 

summary)

 • Introduction

 • Main text (containing data, �ndings, 

etc.)

 • List of recommendations

 • Conclusion

 • References and acknowledgements

 • Appendices
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Short reports

Short reports are less formal in 

structure and usually one to three 

pages in length. The structure will 

be customised to suit the data being 

presented and the audience. Examples 

of short reports include the results of a 

review of customer service standards, 

recommendations for a change of 

stationery supplier or purchase of 

an item, or a progress report on 

arrangements for a function you are 

organising. 

The structure of a short report is usually 

as follows:

 • Introduction

 • Main text (containing data, options, 

�ndings, etc.)

 • Recommendations and conclusion

Due to the short length of these reports 

there is usually no cover page or table 

of contents as the headings provide the 

overall structure.

Here is an example of a one-page report recommending the purchase of a new printer.
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Schedules

A schedule is a list or plan that shows the order in which a number of events will 

take place. 

Schedules can also be used to list tasks that need to be completed. Commonly used 
schedules include itineraries, appointment diaries and timetables.

4e following is an example of an itinerary for internal staA distribution.
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Calendars

Calendars are used to give an overview of events, appointments and meetings 

over a period of time. 

Calendars can also be used by organisations for booking resources, such as a meeting room, 
or for recording information, such as when staA will be on annual leave.

4e following is an example of a calendar showing workshop dates. 4is calendar is to be 
distributed to the company’s external clients; therefore, the company logo, phone number, 
email address and website are also displayed.

Training Calendar  

June 2018

Sun Mon Tue Wed Thur Fri Sat

1
Intro Internet/

Email 

Workshop 

9am–12pm

2

3 4
Training 

Centre Open 

Day 

 9am–12pm

5 6
Microsoft 

Word 

Workshop 

9am–4pm

7 8 9

10 11 12 13 14 15
Adv Internet/

Email 

Workshop 

9am–12pm

16

17 18 19 20 21
Web Page 

Design 

Workshop 

(Day1) 

9am–4pm

22
Web Page 

Design 

Workshop 

(Day2) 

9am–4pm

23

24 25 26 27 28 29 30

For more information contact Techno Train

Phone: 07 3867 1333 Email: info@technotrain.com.au Web: technotrain.com.au
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Mail merge

Mail merges can be used to customise documents including letters, labels, 

envelopes, .yers and statements. They are especially useful when sending a 

mail-out to many recipients.

A mail merge is performed by combining the contents of two documents or =les – one that 
contains the information you are sendng and one that contains the details of the recipients 
(data source). 4e two =les can be in the same program or in diAerent ones. For example, 
the data source may be in Microso0 Excel and the mail merge may be done using Word.

Below is a sample of some labels generated using mail merge in Microso0 Word.

Alex Barney & Co

21 Ergett Street

IPSWICH QLD 4305

We Care Pharmacy

PO Box 38

CHERMSIDE QLD 4032

Ableton Accountants

PO Box 23

CHERMSIDE QLD 4032

Daleys Fresh Fruit

98 Berwick Street

DECEPTION BAY QLD 4508

Practice task 2

Question 1 

Explain the purpose, audience and presentation of the required document in the following 

situations:

a. The advertising department requires a new price list.

b. The payroll department wishes to have new PAYG information distributed.

c. The purchasing department wishes to advise that a product is no longer available.

d. The health and safety committee is having a meeting and asks for agenda items.

e. The company is moving to a new premises.
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Question 2 

Why would it be inappropriate for a staff member’s work-related travel schedule to be circulated 

outside an organisation?
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1C Ensure consistency of style and language

Consistent document layout and design helps to identify an organisation, 

and demonstrates its professionalism and culture to those receiving the 

information. 

You will need to become familiar with your organisation’s word-processing so0ware 
to produce documents. 4is can be used to design and lay out documents so that any 
documents you produce adhere to the corporate image of the organisation and the 
organisational style. 

Organisational style guides

Every organisation has di"erent document requirements, particularly in terms 

of layout and presentation. These are usually outlined in a style guide. 

As part of your induction, you may be shown where 
to access the organisation’s style guide or policies and 
procedures. If you are unsure, ask your supervisor 
where these documents are and how to access 
document templates.

If your organisation does not have a formal style guide, 
you could locate examples of documents that have 
previously been created in the organisation and follow 
them. For example, locate last year’s annual report and 
use it as a guide. Show your supervisor the document 
you are planning to follow so you know you have the 
right type of document and style. You could also ask 
your supervisor if they would like you to create a style 
guide and templates for everyone to use.

Word-processing applications 

Although this learner guide focuses primarily on Microsoft Word, many 

businesses use other types of word-processing software. 

4e type of business will determine the type of application that is used across the 
organisation as well as the resources available to it to purchase, update and maintain the 
so0ware. Find out which one is used in your organisation before beginning your document.

4ere is a lot of overlap between diAerent word-processing applications, and one is not 
necessarily better than the other. 

4e following outlines the strengths and limitations of various word-processing 
applications. 
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Software application Strengths Limitations

Microsoft Word 

One of the most common 

word-processing 

applications, Microsoft 

Word is widely used by 

homes and businesses. 

 • Instant spellcheck for 

grammar and spelling

 • Templates for new 

documents 

 • Track changes function, 

enabling users to see 

edits that have been 

made

 • Bullets and numbering 

are done automatically 

 • Technical support and 

training widely available 

on the internet

 • File protection can be 

used to prevent users 

from altering any part 

of the document 

 • Restrictions on the size 

of the �le Word can 

open (must be under 

512 MB)

 • The auto-correct 

and auto-formatting 

features will override 

inputting 

 • Incompatibility with 

older versions of Word 

or different software

 • Many options which 

some people �nd 

complicated 

 • Targeted by viruses 

and malware due to its 

popularity, requiring 

virus protection 

software when sharing 

�les over networks

Google Docs 

This application allows 

multiple users to create 

and edit text �les in real 

time. 

 • Anyone who has access 

to the document can 

see who is currently 

viewing and editing 

it, and who has made 

which changes 

 • Multiple style and 

formatting options

 • Suggests edits

 • Displays action items 

to show which user is 

responsible for which 

task

 • No Google equivalents 

for the more advanced 

Of�ce programs, such 

as Publisher, Access or 

Visio

 • Unable to link directly 

to Outlook data to 

perform a mail merge 

or read information in a 

calendar

Apache OpenOf�ce Writer 

OpenOf�ce Writer is 

an open-source word-

processing application. 

This means it is free and 

that anyone is able to 

change the software to suit 

their needs.

 • Commands and 

functions in one 

component of the 

software work 

throughout the entire 

suite

 • Compatible with PDF, 

Flash and other �les for 

direct export 

 • Many style and 

formatting options

 • Variety of templates 

and extensions 

available

 • The primary document 

format supported by 

the software is the 

ODF format, not the 

commonly used DOC 

format

 • No publisher program
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Software application Strengths Limitations

Corel WordPerfect 

This is one of the oldest 

word-processing programs 

still in existence, with the 

original release dating 

back to 1979.

Popular with the legal 

profession with options for 

numbering, redaction and 

a pleading editor.

 • Many style and 

formatting options and 

keyboarding shortcuts

 • Headers and footers 

are easy to manipulate, 

and page numbering is 

independent of footers

 • Format converts to 

other �le types such as 

PDF

 • Adds to support and 

training overhead as 

staff will likely need 

support 

 • Reveal codes are 

designed for users 

familiar with software 

coding, a concept 

which many may not be 

familiar with 

 • Converting regularly 

between WordPerfect 

�les and other formats 

increases the risk of �le 

corruption

Microsoft Publisher 

This is a desktop 

publishing application 

suitable for documents 

that emphasise layout and 

design, such as brochures, 

�yers and posters.

 • Many style and 

formatting options, 

design tools and 

picture editing tools

 • Templates reduce time 

and workload and 

make it easy to add 

text, images and make 

changes

 • Comes with a large 

amount of stock art

 • Creates a larger �le 

format 

 • Dif�cult to view edits by 

various people

 • Relies on template 

design, which often 

ends up being generic 

Adobe InDesign

This is a desktop 

publishing application 

widely used in the 

publishing industry to 

create professional-

looking documents with 

an emphasis on design 

and layout, such as 

posters, �yers, brochures, 

magazines, newsletters 

and books.

 • Extensive style and 

formatting options

 • Advanced design and 

layout tools

 • Multiple keyboard 

shortcuts

 • Picture editing tools

 • Can be integrated with 

other Adobe products, 

such as Photoshop

 • Requires a lot of RAM 

to operate

 • Features can take a 

long time to load

 • Files are generally quite 

large, making them 

dif�cult to share 

Why organisational requirements are important

One important factor of production guidelines is to ensure that the time lines 

required for a project or task are met.

A time line is a plan for how long a task will take to complete. It also breaks the task into 
steps and details when each step needs to be completed by. 4e time line needs to allow 
enough time to complete the task, edit and review the document. Your supervisor will 
o0en provide a due date or deadline, but it will be your job to monitor and report on your 
progress. 
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You must also ensure that documents have a consistent style and image so that customers, 
business associates and anyone receiving material from your organisation will instantly 
recognise it as belonging to your organisation.

Clients and customers will form an opinion of an organisation based on the documents they 
receive. In some instances, a document that looks unprofessional or contains errors can be 
the diAerence between gaining and losing a client.

Many organisations have policies and 
procedures for staA to follow, including 
style guides and templates for producing 
documents. In larger organisations 
and government departments, style 
requirements are usually clearly de=ned, 
while smaller organisations o0en have no 
formal documented style guide and staA are 
expected to follow examples of documents 
previously produced.

Conforming to organisational requirements 
will ensure you are able to complete your 
work in an e�cient and timely manner. 
It is very frustrating to have spent hours 
working on the design of a document, only 
to =nd it does not meet requirements. 

Common organisational requirements

Every organisation has di"erent requirements for business documents. 

Most important is to present an appropriate and consistent corporate image by using the 
organisation’s logo, colour scheme and style. 

Make sure you know where these instructions are kept and that you are familiar with them.

What is required or appropriate for one organisation may not suit another; for example, a 
law =rm’s requirements would be diAerent from that of a sports equipment retailer. 

To prepare appropriate documents for your organisation, you must follow established 
guidelines and procedures for production.

Established guidelines and production procedures may include:

 • adhering to content restrictions

 • using templates

 • following the organisation’s style guide

 • including key details in the header and footer, such as the date, the organisation’s 

name and the document title

 • observing copyright requirements

 • delivering the content in the designated timeline.
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Presenting a consistent corporate image

A corporate image for documents can be compared to a sta" uniform.

Many documents can wear this uniform, including correspondence, forms, emails, memos, 
websites, invoices, statements and reports. Just like staA in a company, this uniform may 
vary; for example, managers o0en wear a diAerent company shirt or uniform to other 
employees. Documents can also incorporate diAerent parts of the company’s image into 
their design.

A corporate image has several components, including:

• logo

• colour scheme

• house styles and templates.

Consistent use of the same colours, logos and designs ensures that documents are easily 
recognised as belonging to your organisation.

Organisational style guides

Style guides are used to ensure consistency in the presentation and 4nal look of 

the documents produced by an organisation. 

4is may include using standard templates or using the corporate letterhead for certain 
types of documents that have a similar style and format. Clarify the use of style guides for 
your organisation with your supervisor and colleagues.

Style guides vary between organisations. 4ey o0en provide information on the desired 
writing style and specify the preferred formatting of text and pages with speci=c layouts and 
designs of a variety of documents. 

Document layout and design may relate to:

• margin width

• font type and size

• spacing of text and paragraphs

• alignment of text

• use of headers and footers and what information they must contain

• document reference details, such as a list of resources referred to in a report

• signature blocks and document sign-oA

• use of company logos and slogans, and where they must be located.

Below are some styles relevant to writing style and formatting.

Writing style

 • The use of abbreviations

 • Preferred spelling of particular words

 • Use of hyphens

 • Use of capitals

 • Use of full stops
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Text and page formatting

 • Font size and type 

 • Margins

 • Indenting 

 • Bullets and numbering

 • Headers and footers

 • Borders

4e following is an example of some things that might be included in a style guide.

Dates

The date must be included in the upper right of the document in the following format: Day 

Month Year.

Legislation

When referring to an Act of parliament, if the date follows the Act, the Act must be written 

in italics. If there is no date, italics are not necessary; for example:

Copyright Act 1968 (Cth)

The Privacy Act

Spelling and hyphenation

C

checklist

check-up

Commonwealth

coordinate

cost-ef�cient

Font

Arial 12pt must be used for the body text of a standard letter.

Layout

The left margin must be indented at 4cm.

Headers

File reference details must be provided at the top of each page in italics.

4ere may also be protocols for naming and saving =les and folders in speci=c locations.
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Disclaimers

A disclaimer is a notice placed at the end of a document or email to reduce the 

risk of legal liability.

Disclaimers are generally used when information may be misinterpreted or misused, or if 
con=dential information may be distributed to the wrong person.

4e style guide may include information of when and where disclaimers must be used, such 
as at the bottom of all emails that are sent. 

An email disclaimer may look similar to the following:

This email is intended for the use of the addressee only and may contain con�dential information. 

If you are not the intended recipient, you are hereby noti�ed that any use or dissemination of this 

communication is strictly prohibited. The sender disclaims liability for any errors, omissions, viruses, 

loss and/or damages arising from using, opening or transmitting this email. If you received this 

transmission in error, please notify JC Jackson Photography immediately on (07) 5443 4237, then 

delete this email.

Templates

Templates are used to establish a consistent style and layout for particular 

documents. 

Templates de=ne the preferred layout and text formatting for documents, ensuring 
consistency in design. Most organisations have templates for letters, faxes, memos, minutes 
and agendas. 4ey may also have templates for reports, Iyers and brochures.

4e advantages of templates are shown here.

Consistency

Using templates ensures that information is always presented in the same manner, making 

it easier for readers to locate important information. An example of a common template is 

the layout of a monthly bank statement. Because the information is always presented in 

the same format, the reader knows where to �nd the various transaction details.

Saved formatting

Templates can be as simple or as complicated as required, and may include pre-

formatted margins, fonts, columns, headers and footers, logos, colours and styles.

Template integrity

Because templates are used by various staff members, organisations must ensure that 

no changes are accidentally made to them. For this reason templates should be saved 

in a speci�c location as a special template �le type. This ensure that when you open a 

template document, a new document is created, but the original remains unchanged.

Templates are special =les that are not stored with the rest of your documents. 4is is so 
Word knows where to =nd them so they can be accessed when creating a new document. 
You can see where your templates are being stored by checking the default =le locations.

To create a template, select the File tab and click New. Select Blank document and create 
and format the template you require. Click File, Save As, then choose Browse. In the Save as 
type box, select Word Template (*.dotx). 
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Content restrictions

There are some details you are not permitted to give out in written documents. 

4e kind of information subject to content 
restrictions depends on the organisation, and may 
include results of investigations, =nancial data or 
employee details.

Content restrictions can also be applied to the way 
an organisation words its documents to ensure 
information is not misinterpreted or acted on 
without professional advice being sought. For 
example, a =nancial planning =rm that recommends 
a particular share purchase in its monthly bulletin 
may include a line that says: ‘Please consult your 
=nancial adviser before acting on any of the 
information received in this bulletin’.

When creating documents, check with your supervisor to ensure you are following your 
organisation’s guidelines regarding restricted content.

Copyright legislation

Copyright ensures that content, including text and images, is not copied from 

another source without receiving permission or acknowledging the original 

author. 

4e Copyright Act 1968 (Cth) sets out copyright legal obligations in Australia. To avoid 
breaching copyright law, always record the details of any images or text you are borrowing 
from another source and reference them appropriately (including the author and original 
source). 

Details about appropriate referencing methods can generally be found in an organisation’s 
style guide. Alternatively, ask a colleague or supervisor if you are unsure.

For more information on copyright, visit the Australian Copyright Council’s website at: 
http://aspirelr.link/australian-copyright-council

Determining task requirements

It is important to accurately determine the tasks you need to perform when 

preparing a document. 

4e more organised and e�cient you are, the easier it will be to produce a well-designed 
document that conforms to your organisation’s requirements and meets audience 
expectations.

For example, you need to identify whether you are required to follow an existing template or 
design the document yourself. 
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If you are designing the document you may need to identify whether:

• you are required to include the company logo and, if so, where

• there is a standard font to use

• you are using the recommended language style; for example, not too much jargon and a 
suitable tone, such as friendly or formal

• there are budget constraints (e.g. you might design a great two-page brochure, but the 
budget may only be for one page).

Here are some things you may need to con=rm before beginning your task so that there is 
consistency of style for the document you are producing.

Letters You need to check whether attachments or enclosures are 

necessary, such as references, cheques or brochures. 

Check your organisation’s style guide regarding the type of paper to 

use, such as letterhead paper with the company’s name, address 

and phone number.

The page number and total number of pages are usually shown in the 

footer on each page. For example, Page 1 of 3 may be shown on the 

�rst page of a three-page letter.

You should treat mail merge labels like any other document, applying 

styles and formatting according to your organisation’s guidelines.

Forms and 

templates

You will need to use your design skills for forms and tables. You 

may need to determine if they will be in colour or black and white, 

the paper size they will be printed on and what information must be 

included. The information to be included may depend on whether 

the form is for internal company use or external (client) use. Check 

your organisation’s style guide and templates. You may also ask your 

supervisor to review your design.

Reports You need to undertake a variety of tasks when preparing a report. 

For example, you may need to determine the complexity of the report, 

including its length, structure and the level of detail needed to suit 

the purpose and audience. See your organisation’s style guide or 

templates for the preferred layout.

Schedules As schedules may be distributed either within an organisation or 

to external clients, make sure you follow the guidelines in your 

organisation’s style guide and templates, and get your supervisor’s 

approval for the �nal document and distribution.
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Flyers and 

brocures

Before you can produce the �yer or brochure, you need to know if it 

will be in colour or black and white, the paper size it will be printed on 

and what information must be included. Information that will usually 

be printed on a �yer or brochure includes the company name, logo 

and phone number, although other details may need to be included. 

Check your organisation’s style guide and templates, and always ask 

another person to review your design and �nished �yer or brochure. 

Calendars Calendars are usually generated for the month, but can be 

customised to any length.

You can create a calendar using word-processing or desktop 

publishing software. Like schedules, calendars can be distributed to 

internal or external clients. 

To ensure you uphold the required corporate image, follow the 

guidelines in your organisation’s style guide and templates, and get 

your supervisor’s approval for the �nal document.

Practice task 3

Imagine you work for JC Jackson Photography. You have been asked to create a Iyer 
advertising a special oAer on reprints, which includes a free gi0.

Question 1 

If you were unsure of the requirements of the task, what would be two things you could do to 

ensure you have all the information you need?

Question 2 

List three things that must be included in the document.
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Question 3 

Write three questions you would ask your supervisor to clarify the task requirements.

Question 4 

Which word-processing application would be suitable to produce this �yer?

Question 5 

Give three examples of the types of information you may �nd in your organisation’s style guide.

Question 6 

What is the main purpose of using a style guide?
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Summary

• Ergonomics is about creating comfortable working conditions and setting up a 
workstation to suit your physical requirements, which can prevent undue stress and 
strains. 

• Performing exercises during the day can reduce pain and discomfort.

• Use equipment to improve your posture and be aware of environmental factors in the 
workplace – such as lighting, noise and air quality – that may aAect your health.

• Plan daily tasks to prevent repetitive work being done for long periods of time. 

• Conserving resources at work bene=ts the organisation by reducing costs and bene=ts 
the planet by reducing greenhouse gases and the amount of waste sent to land=ll.

• Documents produced by an organisation include letters, memos, promotional materials, 
reports, forms, calendars and schedules.

• Always clarify the task requirements before producing your document to ensure you 
create the right document type and use the appropriate style and design.

• Organisational requirements ensure all documents produced are consistent in style 
and layout.

• Try to use the best word-processing application for the task.

• Ensure you present a consistent corporate image.

• Always follow style guides and templates where relevant.

• Adhere to content restrictions, such as keeping private information con=dential.

• Observe copyright legislation by seeking permission to reproduce content.
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Learning checkpoint 1 
Prepare to produce documents

Part A
1. Give two examples of how environmental factors such as noise, light and air quality 

could aAect your productivity at work. 

2. Give two examples of conservation techniques that can be done in an o�ce to conserve 
paper and/or energy. 

3. For each of the following tasks, give an example of the type of document that needs to 
be produced and why it is the best choice:

a. Con=rming an appointment time

b. Distributing information to a large number of people regarding a product that is 
on special
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c. Sending a personalised invitation to 50 valued customers to attend a product launch

d. Advising staA in your organisation that a meeting is being held to discuss the new 
enterprise bargaining agreement that is being negotiated

e. Collecting information from customers regarding the quality of customer service 
the organisation is providing

f. Advising your supervisor of your research results into which catering company 
would be most cost-eAective for monthly staA meetings

4. Identify three features that would need to be considered to present a consistent 
corporate image. 
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5. Develop a list of questions you can ask someone to con=rm the task requirements for a 
document you have been asked to produce. 

6. You need to send a digital document in an email to colleagues. 4ere is a limit to the =le 
size that can be sent and received in your organisation, so you need to make sure the 
attached document is not too large. 4e document only contains text, with no images or 
graphs. Which of the following applications would be appropriate to use? Tick all that 
apply.

 � Microso0 Word

 � Adobe InDesign

 � Microso0 Publisher

 � Corel WordPerfect

 � Apache OpenO�ce Writer

Part B
Read the case study, then complete the questions that follow.

Case study
Angelina works as an administration of�cer. Her main tasks are reception duties, word-processing, 

handling the mail and �ling documents. Most days Angelina’s manager gives her urgent work in the 

afternoon that needs to be completed that day. Her time lines are always very tight and she often 

�nds that she has to work during her lunch break and for an extra half hour in the evening. She is 

always exhausted at the end of the day, and is becoming stressed.

Angelina �nds that work is often just dropped on her desk, which makes her desk disorganised and 

dif�cult to use. She cannot adjust her chair and there is glare coming from her monitor. She often 

leaves work with a headache and a backache.

1. Identify three unsafe work practices Angelina experiences.
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2. For each of the unsafe practices you have listed, describe a solution.

3. Explain why work organisation and ergonomics leads to better health of employees.
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One of your main duties when working in an o9ce may be to create and edit 

digital documents. 

Various factors inIuence the structure and layout of a document. You should clarify each of 
these points before starting the design of your document.

You also need to consider the purpose of the document and the information that must be 
included, as well as who is going to be using it. 

4e language style should be suitable for the audience. For example, if you are developing a 
document for clients who are not familiar with the subject matter, you may need to include 
a glossary that explains the technical terms you have used.

A document’s audience also inIuences its design, including the choice of fonts, graphics 
and layout of the information. For example, for a formal report, you could use photographs, 
diagrams and tables to present data and information.

In this topic you will become familiar with the various information requirements and 
design elements that must be considered, along with the functions you can use to ensure 
consistency in your documents.

In this topic, you will learn how to:

2A Design the structure and layout of a document

2B Insert tables, images and charts
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Designing a document refers to the way you structure and lay out the content, 

which will be determined by the information it needs to contain and the target 

audience. 

You need to consider the type of information and the clearest way to display it. For example, 
is the information best communicated in graphs or text? Would you use bullets, tables or 
columns? 

Design aspects to consider include:

 • breakout boxes

 • colour

 • columns

 • graphics, photos and drawings

 • headings

 • letter and memo conventions

 • page layout

 • white space

 • typeface.

Breakout boxes

Breakout boxes can be used to give clearly de4ned borders or edges to content 

on a page. 

Putting an item in a box can make it stand out. Using design elements such as boxes 
consistently on a range of documents can help the audience to quickly locate information 
they have a particular interest in. An example of this is displaying small ads in a newsletter. 
If you use the same positioning and boxed design in each edition, readers will learn to look 
for the information in that format. 

4e following are two designs for a Iyer. You can see how the boxes in the example on the 
right grab the reader’s attention.

2A Design the structure and layout of a document
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Colour

The use of colour in documents can be valuable, both for presenting a 

consistent corporate image and for making items stand out. 

When one section of a document is in colour and the 
remainder is in black and white, the reader’s eye is 
automatically drawn to the coloured section.

You may also need to consider the colour of the paper 
you will be printing your document on, as some fonts 
and graphics may not be easy to see on coloured 
paper; for example, black print can sometimes be 
hard to read on dark red or navy blue paper.

Look at newspapers and magazines to =nd examples 
of the eAective use of colour. Advertisers o0en pay 
extra for coloured advertisements to make them 
stand out.
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Columns

Columns are a popular design element for forms and newsletters. 

In newsletters, columns can be used to create interest and to separate articles. Altering the 
number of columns can give you more options to insert graphics and tables, allowing you to 
fully utilise the space.

Look at the =rst version of the Capricorn State School newsletter. 4e top article appears 
to have too much white space or gaps and the information in the second two articles is 
mixed with the tables. 4is is not a well-designed document. In the second version of the 
document, you can see how the use of two columns in the top half of the page =ts in the 
three small articles and makes them easy to read. 

Formatting tables

When designing forms, tables are often used to insert rows and columns, which 

allow for the e"ective collection of data in the available space. 

If any of your tables extend over a single page, you can use the Heading Rows Repeat 
command to automatically show the table headings on each page.

To do this, create a table and select the row/s that you want repeated at the top of each page. 
You must include the =rst row in the table, but can choose additional rows if desired.

Click the Layout tab, and then select Repeat Header Rows. 4e rows you selected will now 
be repeated on each page of the table.

Note: 4is command only works for automatic page breaks. It will not work if you insert 
manual page breaks in your table.
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Graphics, photos and drawings

Graphics, photos and drawings can be powerful design tools. They can be used 

to break the monotony of continuous text or to clarify information.

4e use of appropriate graphics can help the audience understand the document’s contents. 
An eAective use of graphics could be using an eye-catching picture to draw the audience’s 
attention to a Iyer, or using the company logo on documents to portray a consistent and 
professional image to corporate clients.

Graphs and charts can also be used to represent data, as shown in the following example 
of a sales report. Using this technique is very eAective when presenting data to a corporate 
audience.

Headings

Headings are a simple but e"ective way to give a document structure. 

4ey help the reader to pick out the main topics and discussion points or quickly skim the 
document to get an idea of what they are about to read. Ensure that headings are relevant 
and concise, and use a consistent font and style throughout the document.

Headings are important when creating long reports because of the amount of information 
the reader needs to absorb. Eye-catching and descriptive headings on Iyers and promotional 
materials also help to attract the audience’s attention.
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Page layout

Page layout refers to the way all the di"erent elements on the page come 

together.

First, you must determine what size your document will be – it could be A4, A5, letter, B5 
or a custom size – and how many pages the document will have. If the document is being 
mass-produced (e.g. Iyers and newsletters), the paper size and number of pages will usually 
be determined by the printing budget, so make sure you are clear on your organisation’s 
requirements before creating the document.

You must make eAective use of the space available. Setting appropriate margins for your 
document will ensure you have the optimum amount of space to work with. When deciding 
on the layout of a page, you need to assess the importance of each piece of information and 
make sure the reader’s eye is drawn to what is most relevant. Your organisation’s style guide 
will outline any elements of documents that must be included and you will o0en =nd these 
items have standard positions on the page so as to maintain the corporate image. It is good 
to position these =rst and then consider the layout of the remaining information.

4e following is an example of two versions of a customer satisfaction survey. Both 
documents include all the necessary information, but only the one on the right has an 
eAective page set-up. 4e result is a document that is easy to =ll in, which means that 
customers are more likely to take the time to complete the survey.

Improvements in the document on the right compared with the one on the le0 include:

• a border has been added

• a large, clear heading is used

• plenty of space is allowed for written answers

• question numbers have been added, which will make collation of data easier

• there is eAective use of the whole page (no gap le0 at bottom).
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Typeface

Most word-processing software packages provide at least 50 choices of 

typeface – commonly referred to as fonts. 

Some of the better known ones are Times New Roman, Arial, Calibri and Courier. Some 
fonts can be hard to read and you need to consider this when designing your document. 
It can also be confusing for the reader if you use a lot of diAerent fonts that don’t go well 
together.

Your selection of font will be inIuenced by the audience and purpose of the document 
you’re producing. A report with a large amount of text needs to be presented using easy-
to-read fonts, such as Times New Roman or Arial. Alternatively, a more casual font may be 
suitable for an informal invitation.

In the two examples of reports shown below, you can see how the one on the le0 is far easier 
to read because it uses consistent fonts for the headings and body text. 4e Arial font that 
was selected is easy to read and suitable for a large document. 4e report on the right has 
too many diAerent fonts, some of which are hard to read; the reader may not even be sure if 
all the sections are related.

White space

White space refers to the blank space or gaps around parts of a document.

Leaving appropriate amounts of white space around these elements ensures the document 
does not become too crowded and confusing or that items don’t look too isolated and out 
of place.

It is not essential to =ll up every bit of space on the page, but you shouldn’t leave a big part of 
it blank either. Sometimes leaving some space around an item can draw attention to it.
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Practice task 4

Read the case study, then answer the questions that follow.

Case study
Jennifer works as an of�ce assistant for a training organisation. Her supervisor assigns her the 

task of creating a monthly newsletter. She assumes the newsletter is going to be distributed to the 

organisation’s clients. She spends several days working on the newsletter, researching various hints 

and tips, creating a training calendar and preparing trainer pro�les.

She presents her draft newsletter to her supervisor and learns that she was actually meant to create 

an informal staff newsletter for the organisation’s employees. Most of the work she has done was 

unnecessary.

Question 1 

What might the consequences of Jennifer’s actions be?

Question 2 

Consider an internal memo and a promotional brochure. How would the purpose of each of the 

following documents affect its design and layout?

a. Internal memo

b. Promotional brochure
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Question 3 

Complete the table below by describing how each of the following design features can be used.

Design feature Function

Breakout boxes

Colour

Columns

Graphics, photos and 

drawings

Headings

Typeface

White space

Designing the document to enhance readability and 
appearance

Documents are important communication tools that need to be suitable for the 

audience and purpose, as well as being visually appealing and easy to read.

When producing digital documents you should spend time working on a design that is 
readable, eye-catching, and meets task and organisational requirements. Remember that 
everyone has a diAerent opinion, so don’t forget to ask for feedback.

4e following design elements are basic guidelines you should follow to ensure the 
readability of your =nished document. 

Balance

Balance refers to the way text and graphics are distributed on the page. A document is 

unbalanced if most of the content is at the top or bottom, left or right of a page. There 

should also be a balance between the amount of text and graphics on a page so that the 

page doesn’t look overcrowded or dominated by one feature. Distributing the text and 

graphics throughout the document will help to achieve balance.
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Positioning of graphics

When placing headings, body text and graphics on a page you need to ensure that they 

are positioned so the information is easy to understand. The position of headings and 

graphics can either help or hinder the reader in understanding a document.

As a general rule, in documents such as reports and newsletters, a graphic should not 

be directly under a heading as this area is reserved for the introductory paragraph. 

Graphics should be placed close to the text they relate to.

Simplicity

One way to make text more readable is to use a simple design that is not overcrowded, 

disjointed or busy. The text should be large enough to read and should �ow in a logical 

manner. Try not to change between single and multiple columns more than once on each 

page, use borders and boxes sparingly, and stick to one colour scheme. Remember, you 

don’t have to use every feature offered by your software on each page!

Text �ow

Text �ow refers to the way passages of text are positioned in a document. The way text 

�ows in a document is one of the most critical elements in�uencing its readability; if 

text �ow is arranged carelessly, the reader can become confused. Text can �ow from 

one column to another or from one page to another. Newsletters, newspapers and 

magazines regularly have to split articles across columns or pages in order to �t text in, 

so it is vital to ensure the reader can locate the follow-on text.

When text from a particular article has to �ow over more than one page, you may decide 

to include information that tells the reader where to �nd the rest of the article. You might 

add ‘continued on page 2’ at the bottom of the article, then add ‘from page 1’ at the top 

of the article on page 2. Alternatively, you could use an arrow indicating to turn over the 

page to continue reading.

Typography

Typography refers to the use of various text formatting and font options in the 

production of documents. 

Using eAective typography allows you to =netune a document and add the =nishing 
touches. Remember to ensure you are still able to complete your document on time, as some 
of these design elements can become time-consuming. 4ere is more to using text eAectively 
than just choosing a font type, font size and text alignment – as shown below.

Font The font you choose can have a huge impact on the amount of space a 

passage of text uses. Try typing the same line of text in several different 

fonts and you will notice a difference. For example, look at the different 

lengths of the sentences below.

This is a line of text in Times New Roman.

This is a line of text in Arial.

This is a line of text in Courier New.
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Paragraph 

and line 

spacing

Another technique you can use to achieve additional emphasis on 

headings is to adjust the spacing before and after headings and lines of 

text. To do this, select the paragraph icon, then make adjustments where 

it says ‘Spacing’.

Practice task 5

Your company is hosting its annual end-of-year staA party and you have been asked to 
design a Iyer to advertise the function to staA. Information to be included in the Iyer is as 
follows:

Company name: Pack and Go Express Couriers

Date: 16 December 2018

Time: 5.00 pm until late

Venue: Rush Restaurant and Club

Address: 41 Villa Street, Fremantle

RSVP: 10 December 2018

Dress: Themed party: 80s revival – prize for best dressed

Cost: No charge

Program:

5.00 pm Pre-dinner drinks

6.30 pm Buffet dinner

8.00 pm Awards and speeches

9.00 pm Entertainment – live band

Create the document in Word. Ensure you apply what you have learnt in this topic about 
document design and layout. Save and print your =nished document.
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AutoCorrect

You can use a variety of automatic functions to ensure consistency when 

creating a document. 

AutoCorrect is a feature of Word that automatically corrects common typing errors. 4is 
is a powerful tool because of the time it saves when proofreading for spelling and grammar 
errors. Have you ever noticed when typing that an error will automatically correct itself? 
4at’s AutoCorrect at work. For example, if you type ‘teh’, when you hit the space bar it is 
corrected to read ‘the’. Word has a range of common errors already included as entries and 
you can add your own to these. If you don’t want a word automatically corrected, simply 
click Undo (or press Ctrl+Z).

To create an AutoCorrect entry, select File, Options, then select the Proo*ng tab and 
choose AutoCorrect Options.

Type the incorrect version of the word in the Replace box. Type the correct version in the 
With box. Click Add.

To remove an AutoCorrect entry, scroll down and select the entry you wish to remove from 
the list by clicking on it, then click Delete.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

57

Topic 2
Design word-processed documents

Header and footer

Headers and footers are used to present important information at the top or 

bottom of each page. 

Depending on the document type, headers or footers may be used to display information 
such as:

• the name of the organisation

• the document title

• the =lename and path

• page numbers

• the location, date and time the document was created.

4e contents of headers and footers can be saved for use in templates.

A header appears at the top of a page and a footer appears at the bottom. 4e information 
that appears in headers and footers is the same on every page of a document, or within 
sections of a document.

To insert a header and footer, select the Insert tab and click Header. Select a Blank (Three 
Columns) style from the drop-down menu. 

From the Header & Footer Tools tab you can insert:

• page numbers

• the date

• the time (with an option to update automatically).

Many organisations require the date or time to be automatically inserted into documents. 
4is helps to track when documents were created or edited, acting as a form of version 
control.

Ensure that English (Australian) is selected as the language so that the day, month and year 
will be displayed in the correct order, then select a format from the le0-hand side.

If you want the date or time to be updated each time you open the document, click Update 
Automatically when inserting the date or times. If this is not ticked, the date or time will 
not change when the document is updated. 

When creating large documents, such as reports or booklets, you may be required to display 
diAerent information in the headers and footers of odd and even pages. To create alternate 
headers and footers, select the header or footer you have created by double-clicking it. Tick 
Di/erent Odd & Even Pages in the Options section.

You will now see that the header and footer names have changed to Odd Page Header and 
Even Page Header. Enter the information required into the odd and even headers. 
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Another option is to have a diAerent =rst page. 4is is useful when creating documents that 
have a title page where headers and footers are not displayed. For this option, simply tick 
Di/erent First Page.

Styles

When you are creating a document that uses consistent headings and text 

styles, the most e9cient way to format it is to create styles. 

A style is a set of text formatting conditions that are applied to characters or to a paragraph. 
4e advantage of using style sheets is that when you change the style, Word automatically 
changes all characters or paragraphs in the document that uses that style.

By creating templates with well-organised, sensibly named styles, you will increase your 
document production e�ciency as you will be able to format text in just one or two steps 
rather than having to take several steps each time.

Creating styles for frequently used documents such as letters, Iyers and brochures will save 
you time because you can just apply the style to each paragraph in the document.

To identify a paragraph’s style, select the paragraph by clicking anywhere inside it. Select the 
Home tab and click on the small downwards arrow below the Styles box. 4e Styles window 
will now appear.

Each style is identi=ed as either a paragraph style (marked by the symbol ) or character 
style (marked by the symbol ). Experiment with using diAerent styles, and changing and 
modifying styles.
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You can move the styles box to diAerent sides of the page you are working on by dragging it 
with your cursor.

To create a new style, select the text you want to create as a new style. Select the drop-down 
arrow at the edge of the style box and select Create a Style. You can also select the New 
Style button

  
at the bottom of the Styles box. Give the style a name and click OK.

4is style will then appear in the Styles gallery.

To modify a style, click on the drop-down menu next to the style you wish to modify in 
the Styles box. Click Modify Style. You can then change the font size and type and access 
additional formatting options by selecting the Format drop-down menu. 

4e changes you make will apply to all text that has that style applied to it.

Default settings

By becoming aware of the default settings available in your software, you can 

maximise the e9ciency of your data editing. 

Default settings determine the options that automatically appear when you perform a task. 

You can change the defaults for a variety of tasks by clicking the File tab and choosing 
Options. Review the contents of each option until you =nd the setting you want to change.

Some examples of defaults you can set are provided here.

Default �le location

The folder that �les will automatically be saved in.

Default printer

The printer a document will be sent to when you click the print icon.

Default language

Allows you to set the language for your documents; for example, English (Australia).

Understand a document’s formatting

One of the greatest challenges you may face when using documents someone 

else has created is working out how it was formatted. 

One of the most useful tools in Word is the Show/Hide option. 4e Show/Hide button 

 on the Home tab allows you to see the document’s non-printing characters. 4e non-
printing characters let you see a range of information, including where the paragraph ends, 
where spaces have been placed and where the Tab key has been used. When you become 
familiar with the non-printing characters, you can use them to check that the formatting of 
your document is consistent.

Below are some common non-printing characters.
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Paragraph symbol (also known as pilcrow)

This mark is created when you press the Enter key to end a paragraph. Word does 
not look at paragraphs like we do; it relies on the use of the Enter key to know 
where they start and end.

Space

This small dot indicates that the Space bar has been pressed. You can tell how 
many times the Space bar has been pressed by the number of dots that appear 
between words.

Non-breaking space

A non-breaking space can be created by pressing Ctrl+Shift+Space. You use 
a non-breaking space if you want to ensure that two or more words are always 
printed on the same line and never automatically separated by Word’s automatic 
line breaks.

Tab space indicator

This symbol is used for two purposes in Word. It is used to indicate that the Tab key 
has been pressed on the keyboard, and it is also used in numbered or bulleted lists 
as the tab space between the number or bullet and the text.

Line break

A line break can be created by pressing Shift+Enter. It is used to start a new line 
without starting a new paragraph. This means that when you apply formatting (for 
example, indenting) to the text, Word will treat the lines as one paragraph.

This example shows non-printing characters, allowing you to see the formatting that was 
applied. You can see that several of the eAects have been created using an ine�cient method 
that may cause problems if the document is edited at a later date. 
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When you look at the document, you can see that the operator has not used good word-
processing practice. 4e extra spaces used to create indents and the manual line breaks are 
likely to cause issues for anyone who is editing the material. 4is table lists the mistakes and 
the correct method that should be used.

Mistake Correct method

Incorrect number of 

spaces between words

Only press the space bar once between words.

Enter pressed at the end 

of each line

Allow the text to auto-wrap as you type. This will ensure 

that changing the font or other formatting will not cause 

problems later on.

Spaces used to indent 

text

Create the text as one paragraph, then use the Increase 

Indent button in the Paragraph grouping under the 

Home tab.

Changing font size of 

paragraphs between 

sections of text to adjust 

the gap between lines

Use the Line and Paragraph Spacing button in the 

Paragraph grouping, rather than having a blank line 

between paragraphs.

Indents

The indent of a line of text or paragraph refers to how far it is positioned from 

the margin.

Text can be indented on either the le0 or right side of the paragraph, or both. Indenting is 
useful for drawing attention to sections of text. It can be used very eAectively to emphasise 
lists of data, including bulleted lists.

To indent a section of text, select the Page Layout tab and adjust the settings under Indent.

Alternatively, click the small downwards arrow next to Paragraph on the Home tab and 
adjust the settings under Indentation.

Font styles, size and colour

Your word-processing software has many fonts to choose from and you can 

apply a range of sizes, colours and e"ects to these. 

Changing the size or colour of a section of text can add impact to your document.

Be careful not to overuse these features as too many fonts can make a document hard 
to read. 4e document type, purpose and audience are important considerations in font 
selection. You would most likely only use two to three diAerent fonts, sizes or eAects in a 
business report: one for major headings, one for minor headings and one for body text. 
However, if you were preparing a newsletter or Iyer, you may use several diAerent fonts to 
make important information stand out and look eye-catching.
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You can select a font from the drop-down menu in the Home tab. For the full range of font 
formatting options, click on the arrow in the lower le0 of the Font section to open up the 
dialogue box.  4is gives you access to additional eAects and a handy preview window so 
you can see how your changes will look.

You can also apply styles such as Bold, Italics and Underline by clicking on the 
appropriate button.

To apply a font colour, click on the arrow next to the Font colour symbol and choose a 
colour from the palette shown. 4e selected text will be changed to reIect your selections. 

Captions

Captions are words you can add to tables, graphs and pictures. 

4ey can be used to guide the reader, either to help them identify which graphic you are 
referring to in the text or give more details about an image. Captions are used to name 
diagrams or data in tables or to identify people and other details in photos.

To add a caption, select the picture, graph or table that you want to add a caption to.

Select the References tab and click Insert Caption.

Select a Label from the list or click New Label to make a new one. 4e label you have 
selected will appear in the caption box. 

Click in the Caption box and type your caption.

Select the position for the caption, either above or below the selected item, then click OK.

To remove the label from your caption, click on the caption text box that has been created 
and edit the text.
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Bullets and numbering

Using bullets and numbers to clearly separate points in a list can improve the 

presentation of text. 

A variety of number formats and bullets are available in your so0ware and you can even 
import pictures to use as bullets. 

Numbers

Numbers are generally used to denote items that are in order. For example, if you were 

writing a list of the top three sales people for an organisation, you could write:

1. James Harker

2. Rose Marcus

3. Peter Jenz

Numbers are also used when creating step-by-step instructions for people to follow, 

such as a recipe or procedure.

Bullets

Bullets are used to list items that are not in any particular order but need to be shown 

clearly in a group. 

For example, a company might include a list of staff who attended a workshop in the 

following format:

 • Hank Palmerston

 • Ally Holden

 • Thanh Ng

They can also be used to separate items that have the same stem. For example:

To increase staff morale, it was decided that:

 • a new coffee machine would be purchased

 • Friday night drinks would start in the of�ce from 4.30pm

 • staff would receive one rostered day off per month.
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To format a list, select the Home tab, then click on the drop-down menu for Bullets or 
Numbering. Select a bullet or numbering type from the library or choose De*ne New 
Bullet or De*ne New Number Format to make adjustments. Click OK.

Footnotes and endnotes

Footnotes and endnotes are used to provide additional information, 

clari4cation or references in documents. 

4ey are commonly used when quoting a book or website or acknowledging an idea from 
another source. Footnotes are placed on the bottom of the page with the referenced text, 
while endnotes are positioned at the very end of the section or document. 

When creating footnotes and endnotes, use a consistent style of referencing. Generally the 
document will have one or the other, not both. You will need to ask your supervisor or refer 
to your organisation’s style guide for the preferred referencing format.

Word will automatically assign the 
footnote and endnote numbers and update 
them should you remove or add any 
additional footnotes. 

To insert a footnote or endnote, click next 
to the section in the text that requires the 
footnote. Select the References tab and 
click either Insert Footnote or Insert 
Endnote.

You will be moved to the bottom of the 
page or section and can type the reference 
details. 

Each footnote or endnote you create will 
have a corresponding number, letter or 
symbol that links it to the body text you 
originally selected. You can change this 
format by clicking on the arrow in the 
bottom right of the Footnotes section.

To remove a footnote or endnote, select the 
superscript number indicating the footnote 
or endnote, then delete the number by 
pressing Backspace on the keyboard. 
Check that the number or symbol was 
deleted in both locations (both in-text and 
at the bottom of the page or section).
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Annotated references

When you design a document that will be edited by another person, leaving 

some notes or comments to guide them in using the document can be helpful. 

For example, you might tell the document user where missing information needs to be 
entered or give details about formatting.

4is comment tells the user how the space above the paragraph was created.

To create comments, highlight the text you would like to make a comment about. Select 
the Review tab, then click New Comment. You can then type your comment in the box 
provided.

To view comments that have been made in the document, click the Show Markup drop-
down menu in the Review tab and ensure Comments is ticked. You can also use the drop-
down menu above this to select All Markup. 4is will display all the comments and tracked 
changes in the document.

To delete a comment, right-click on the comment box and select Delete Comment from the 
drop-down menu.

Borders

You can use borders to organise or emphasise parts of a document. 

In Word, you can add a variety of borders to paragraphs, selected text, tables or the entire 
page. Borders can be used in documents such as newsletters to accentuate and draw 
attention to important items; for example, an advertisement for an event.

When creating promotional documents such as Iyers, brochures and invitations, the border 
type selected will contribute to the style of the document. For a formal look, choose one of 
the line styles.

To create a border around one or several paragraphs of text, select the paragraph you want a 
border around. Select the Home tab, then click on the Borders drop-down menu and select 
Borders and Shading.

Shading and Borders

Here you can change the setting, style, colour and width. You can also choose to put a 
border around the entire page by navigating to that tab. You can choose which sides have a 
border by clicking on the borders in the preview on the right-hand side. You might also like 
to experiment with paragraph shading by selecting the Shading tab.



66
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU313
Design and produce digital text documents

Practice task 6

You work for Total Accounting Solutions and your supervisor has requested that you create 
a new letter template. 4e following guidelines need to be followed when designing and 
creating templates: 

• Organisation name, address, phone number and email address are to be included in 
the header.

• Organisation details:

Total Accounting Solutions

PO Box 459

CAULFIELD VIC 3185

Phone: 03 9847 6651

Fax: 03 9847 6612

Email: info@totalaccounting.com.au

• 4e company slogan is to be included in the footer. 4e company slogan is: ‘Helping you 
through accounting and =nancial advice’.

• Le0 and right margins should be 2cm.

• Top and bottom margins should be 1.5cm.

When you have =nished, save your template as ‘TAS Letter template’.
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Tables are used in documents to display information and data in rows and 

columns. 

To create a table, select where you want the table inserted. Select the Insert tab and click 
Table. From the drop-down menu you have a number of options to create a table. You can 
move the pointer over the grid to choose the number of rows and columns that you want 
– as you do this a preview of your table will appear in the document. You can also select 
Insert Table and enter the number of columns and rows you want, then click OK. A table 
will now be inserted in the text.

Alternatively, you can select the Draw Table option, which allows you to draw the table 
directly into the document through a series of boxes that you can join together. 4is can 
be helpful if you need a speci=c design for your table, such as some columns that are much 
wider than others.

Another method is to enter a spreadsheet into the document and input data directly. To do 
this, select Excel Spreadsheet. 4e following table will appear.

You can also use the Quick Tables menu, which oAers prede=ned templates that you can 
choose from.

Once you have created a table, you can click into each of the cells and enter your data. To 
move between cells, you can click into each cell, use the arrows on the keyboard to navigate, 
or press Tab to move right and Shi6+Tab to move le0.

Remember, when experimenting with the diAerent tools, you can use your undo tool on the 
Quick Access Toolbar or press Ctrl+Z to undo any action.

Adjust the table layout

Before you can apply any formatting or manipulate data in any part of a table, 

you need to be able to select the speci4c parts you want to format. 

When you click into the table you have created, you will see a new section appear in the 
Ribbon called Table Tools. 4e Layout tab gives you access to features, such as inserting 
or deleting rows and columns, changing the height and width of cells, and merging or 
splitting cells. 

2B Insert tables, images and charts 
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Merging allows you to join cells together. 4is would be useful if you want to have a title 
across the top row of the table and a number of columns underneath. Splitting lets you break 
one cell into several parts. You can also split the table into two by selecting Split Table.

Just as you can set the alignment of text or graphics, you can change the alignment of the 
contents of cells. You can choose to centre text horizontally and/or vertically, or align text to 
the top or bottom, le0 or right of a cell.

4e following information gives you further details about selecting diAerent parts of a table.

Move your 
cursor onto 
the top edge 

of the first 
column to be 

included in the 
selection. The 

cursor will change 

to a black
  

arrow.

Click and drag across the 
table to select the required 

number of columns.

Move your 
cursor to 
the top left-
hand corner 
of the table. 
The cursor will 
show a four-

arrow symbol
 

.

Click the symbol and 
all cells in the table will 
be selected. You can also use 
this icon to click and drag the table 
somewhere else in the document.

Move your cursor to the left edge 
of the first row to be included 

in the selection. The 
cursor will change to a 

white
  

arrow.

Click and drag 
down the table 
to select the 
required 
number of 
rows.

Put your cursor into the first cell in 
the block of cells you want to 
select.

Click and drag your 
cursor over the 
remainder of the 
block of cells.
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ls
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n

Select a row

Select the  

w
hole table

To insert columns and rows, click in the cell adjacent to where you wish to create a new 
column or row. Click the right mouse button and select Insert from the drop-down menu. 
Choose where you wish the new column or row to be inserted (to the le0, right, above or 
below the selected cell).

If you require more than one column or row, you can press Ctrl+Y to repeat the insertion.

To delete columns or rows, right-click in the column or row you wish to delete, then select 
Delete Columns or Delete Rows from the drop-down menu. 

To maximise readability and accommodate information needs, it may be necessary to resize 
the columns and rows of the table. You can do this in several ways, as the followng outlines.
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Using the mouse

Move your mouse to the right edge of a column you want to resize. The cursor will change 

into a two-headed resize
  

arrow.

Click and drag the column to the required width. Note: This method will change the width 

of adjacent columns.

You can use a similar method to adjust the height of a row.

Using the menu

Select a column or row to resize.

Select the Layout tab. Click the arrow to the bottom right of the Cell Size section. The 

following will be displayed.

If you click the drop-down menu you can click on the Previous Column or Next Column 

buttons to change the width of adjacent columns.

Select a row and repeat these actions to modify its size.

Using the ruler

This applies to columns only. Move the pointer to the hashed area on the ruler to resize. 

The pointer will change to a double-headed arrow.

(Note: This method will maintain the width of adjacent columns.)
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Design and format tables

There are many options for designing and formatting tables to improve the 

readability and visual appeal.

4e Design tab gives you access to many diAerent design tools. 4e Table Styles section 
is particularly useful to apply a set design. Use the drop-down menu to see more designs. 
As you hover your cursor over each one, a preview will display in the table on your page. 
Alternatively, you can modify a table style or customise your own using the shading and 
borders options in the Design tab.

To apply borders, select the cell or range of cells you want to apply the border to. Click 
the drop-down arrow underneath Borders in the Design tab to see border options. 
Click the border you want to add or remove. You can also select Borders and Shading 
to format borders. For example, you can add a border to only one side of the cell by 
clicking on a border style, then clicking on the side of the cell you wish to apply it to in the 
Preview window.
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In addition to adding borders to particular cells, you can also individually select block 
shading of cells.

To apply shading, select the cell or range of cells you want to apply shading to. Click the 
drop-down arrow underneath the Shading button and then click on the shading you 
would like.

Practice task 7

Using the instructions provided in this section, create a table with seven rows and three 
columns. Merge the top row, then split a couple of cells, and apply diAerent borders and 
shading options to various cells. Save your document with the name ‘Table Practice’.

Inserting pictures 

Inserting pictures into a document is easy when they are in a digital 4le format. 

Your word-processing so0ware will recognise a large 
range of =le formats, including Windows Bitmap 
(BMP), JPEG File Interchange Format (JFIF) and 
Graphics Interchange Format (GIF). Digital photos 
are o0en used in Iyers and newsletters.

When you have a hard copy printout of a picture 
or logo you want to insert in a document, you can 
import it using a scanner. 4e quality of the image 
will depend on the quality of the hard copy and the 
settings on your scanner.

To insert a picture into your document, select where you want to place the image. Select 
the Insert tab and click Pictures. You can then go to the drive and folder containing your 
picture, select the picture you want and click Insert. Adjust the size and position of the 
picture as required.

Moving and resizing pictures

Once you have inserted a picture, you may need to move and resize it, or wrap 

text around it to change how it appears on the page.

To resize and move graphics and objects, click on the object to be resized and resizing 
handles will appear on the corners and sides of the object. Position the pointer over one of 
the handles and the pointer will change to the resize arrow. Click and hold the le0 mouse 
button and drag to change the object to the desired size.

To move an object, position the pointer on the object so it changes to the move  arrow. 
Click and hold the le0 mouse button and drag the object to its new location.

When you click on an image, a circular arrow will appear at the top. 4is is for rotating 
the object. A box will also appear alongside the object, which oAers layout options such as 
having the object in line with the text or to wrap text around the object. 
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4ere are several diAerent wrapping styles, as shown here.

Square The text will wrap around the object. You have the option to allow 

the text to wrap around both sides, the left only, the right only or 

largest only. Largest only is the side of the graphic with the most 

space.

Tight This style is similar to square. However, if the graphic is not 

square the text will wrap in against the edges of the graphic.

Through Occasionally a graphic may have a gap in the picture. This form of 

text wrapping will wrap tight around the picture, and text will also 

be placed in any of the gaps.

Top and bottom Text will be placed above and below the object. No text will 

appear on the left or right sides.

Behind text The object will be placed behind the text. This means that text 

will �ow over the top of the object. This is similar to a watermark 

effect.

In front of text The object will be placed in front of the text. Using this option, you 

may not be able to read all of the text if it is behind the object.

In line with text The object will be placed in line with the text. You can select the 

object and move it like you would any section of text.

4e following example shows the way the graphic and text interact using each diAerent text 
wrapping style.
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Table of contents 

A table of contents can be a useful way to navigate large documents, such as 

reports.

You can insert a hyperlink (text or graphic that you click on to take you to another location) 
either from one part of a document to another part or to an external =le or website. 

A reference hyperlink is included in the table of contents so that when you press the Ctrl key 
on the keyboard and click on an item in the table of contents, the document will jump to 
that position.

To create a table of contents, move to the position in the document where the table of 
contents will be positioned. Select the References tab and select Table of Contents. 4en 
choose one of the built-in options, or choose Custom Table of Contents. 4is will generate 
a table of contents based on the heading styles that have been applied throughout the 
document. If a heading is not showing up in the table of contents, the heading style may not 
have been properly applied. 

To jump to a heading in the document, hold down the Ctrl key and click on the item in the 
table of contents.

Practice task 8

Open a new blank Word document. Find and insert three pictures. Add descriptive captions 
to each of the pictures, then apply the Top and Bottom text wrapping style. Write a 
paragraph of text before and a0er the pictures. Save and close the document.

Summary

• When creating a document, clarify the purpose, audience and information 
requirements.

• Consider a range of design aspects and elements when working out the structure and 
layout of your document.

• Use design and formatting functions to ensure consistency of design and layout.

• Design concepts should be incorporated into your documents to enhance their 
readability and appearance.

• 4e style and layout of documents should follow your organisation’s requirements.

• Create and use styles to ensure headings and text styles are formatted consistently.

• Change the layout, format and design of tables to improve readability and visual appeal.

• Insert and format graphics to break up text and make documents more visually 
engaging.
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Learning checkpoint 2 
Design word-processed documents 

Part A
1. Create an A4 Iyer advertising the Techno Train Training Centre Open Day. Include the 

Techno Train logo in your Iyer by scanning it or visiting http://chilp.it/a646f9f. 

Information to be included on the Iyer:

Date: 5 June 

Time: 9am – 3pm

Phone: 07 3876 1333

Email: info@technotrain.com.au

Website: www.technotrain.com.au

Address: 22 Hart Street, CHERMSIDE QLD 4032

Activities:

• Meet the trainers

• Ask an expert

Short training sessions:

• Computer introduction: 45 minutes

• Using a digital camera: 45 minutes

RSVP: 30 May 

2. Write a report about the document you have created. Include the following information:

a. A description of the purpose and target audience of your document

b. 4e design aspects and elements you considered when creating the document and 
why you applied them.

3. Research a topic of your choice on the internet and write a report about it. Examples of 
topics you could choose include: 

• the latest fashion trends

• a comparison of car makes and models

• a new-release movie

• information about a new so0ware package or computer game.

Your report must include:

• clear descriptive headings

• at least two footnotes referencing the websites or other sources that were used in 
your research

• a footer showing the page number and the current date

• at least one graphic or table.

Ensure that you create and use style sheets to format your document. Save and print 
your report.
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Part B
Access and download landscaping-newsletter.docx either by scanning the 
QR code provided or at: http://chilp.it/d727ba2. 

1. Examine the document and list *ve design problems or errors.

2. Recreate the document using the principles of design and layout you have learnt. You 
can either copy and paste into a new document, or edit the existing =le. Save and print 
your new version.

Part C
1. Create a document that allows you to demonstrate the following:

• Two types of indents

• Two diAerent bullet styles

• 4ree diAerent fonts

• A graphic with a caption

• Two examples of borders

Save and print your document.
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2. Produce a document similar to the following example. Your document should use the 
same layout (positioning of text and images), similar heading styles, tables and margins. 
Ensure you create appropriate styles to support the formatting of the document. Save the 
document as ‘Capricorn newsleter.docx’ and print it.

• 
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When producing digital text documents, editing, printing and storing 

documents are important steps to follow. 

You should also use various so0ware functions to ensure that documents are produced in 
the most timely and cost-eAective manner. 4e advanced functions explained in this topic 
will allow you to streamline your operations and ensure that documents are produced 
consistently and e�ciently.

In this topic you will learn how to:

3A Use advanced so0ware functions

3B Import and edit text and other data

3C Meet time lines and overcome problems with document production

3D  Save and print documents
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Word-processing software programs contain hundreds of software tools to 

assist you in creating and editing documents. 

Knowing which functions to use to produce various 
eAects ensures you can create professional-looking 
documents and complete your work e�ciently.

Just like any trade, the more tools you have available, 
the easier it is to get the job done. If you complete 
tasks using the correct formatting and functions, 
your colleagues will be able to easily edit and make 
changes to the documents you have created. For 
example, if you did not know how to use section 
breaks to change the number of columns on a page 
and you had incorrectly used two tables to create 
the same eAect, the next person to use the document 
would have to reformat the contents correctly into 
two columns. A lot of valuable time would be wasted.

Sections

Sections are used to separate parts of the document with a di"erent layout, 

such as margin size, page orientation or number of columns. 

4ey allow you to have control over the =nal look of your document. For example, if you 
want to produce a document that has one page in portrait orientation and the next page in 
landscape, you would use a section break.

To insert a section break, select where you would like the section break inserted. Select the 
Page Layout tab, then click Breaks to open the drop-down menu. Select the type of break 
you would like from the options. Click OK. A section break will be inserted and will look 
similar to one of the following.

You can only see section breaks when the non-printing characters are on display. Click the 
Show/Hide

  
button in the Home tab to show them.

4ere is a range of section break types available, which are described here.

Next Page

A new page is started and the new section starts on this page. This option is useful 

for having more than one page orientation in a document. You can insert a Next Page 

section break, then change the page orientation on one of the pages from portrait to 

landscape or vice versa.

3A  Use advanced software functions
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Continuous

A new section is inserted on the current page. This technique is used to create pages 

with more than one column format or with different margins on different parts of 

the page.

Even Page or Odd Page

A new page section is started on the next even or odd numbered page, depending on 

which command you choose. Additional pages will be inserted into the document as 

required. This technique is used in books where each new chapter must start on either 

an odd or even page consistently throughout the document.

4e following example illustrates how section breaks are used.

To check which section you are currently in, look at the status bar at the bottom of the 
screen. 4e section number will be shown as ‘Section’ followed by the number; for example, 
Section 1, as shown here.

To remove a section break, click just before the section break or highlight it (hidden 
characters must be shown). Press the Delete key on the keyboard and the break will be 
removed.

In this example, the �rst continuous 

section break is used to change 

from one heading, ‘Capricorn State 

School’ to two columns for the 

information underneath.

The second continuous section 

break is used to change from two 

columns to one so that the larger 

article is presented in an easy-to-

read layout.

Continuous section breaks
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Columns

Columns have a variety of uses, particularly when designing forms, newsletters 

and brochures. 

You can use several formats and options when creating columns. You can: 

• divide your page or section into a number of columns or columns of diAerent widths

• change the spacing between columns 

• choose whether or not to include a line between the columns.

Unless you have speci=ed otherwise, new documents created in Word will automatically be 
formatted with one column.

To change the number, width and spacing of columns, select the Page Layout tab and 
click on Columns. Select one of the pre-set column options from the drop-down menu or 
select More Columns and manually enter the number of columns you want, along with the 
desired Width and Spacing. Click OK.

Practice task 9

Using a document that contains large blocks of text, make the following changes.

Change the page layout to have two even columns. Apply the functions and design skills 
you have learnt so far to create an attractive one-page newsletter. Ensure you adjust the 
margins and have at least two sections with diAerent numbers of columns on the page. Save 
your work.
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Software packages enable users to integrate data from a range of sources. 

Due to the variety of so0ware programs available, there is a growing trend towards 
integrating the content generated in them. 

A common use of this function is to import data from an Excel spreadsheet into a Word 
document. Data can be imported as an object from one program to another, saving a lot 
of time.

When content can be exchanged between diAerent applications, the programs are referred 
to as compatible. Many so0ware packages now give users the option of opening a =le that 
was created in a diAerent so0ware package. 

You can also save a =le in a format that can be opened in another so0ware package. To do 
this, select Save As and choose a diAerent option under the drop-down menu Save as Type. 

However, because of the diAerences between so0ware packages, occasionally some 
formatting may be lost when this method is used.

Importing data

You can insert the contents of a text 4le or a 4le that you have created in 

another program. 

4e contents of the =le you insert will keep its formatting. 4is technique can be useful 
when combining information from several sources, such as when you are collecting articles 
from various authors for a newsletter.

To insert a =le into a document, select where you want to place the =le. Select the Insert 
tab, and click the Object drop-down arrow, then click Text from File. Choose the drive and 
folder, then select the =le and click Insert. 4is will insert the entire document. 

If you just want to insert a few paragraphs of text, you can open this document separately, 
highlight the text you want to insert and either right-click and select Copy or press Ctrl+C 
on the keyboard. You can then paste it into your document by right-clicking where you 
want to insert it and selecting one of the paste options. Alternatively, le0-click and press 
Ctrl+V on the keyboard.

3B Import and edit text and other data



82
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU313
Design and produce digital text documents

To insert an object from another program, select the Insert tab, click Object, then choose 
Object from the drop-down menu. Select the Create from File tab, then click Browse. 
Locate the drive and folder containing the data you wish to import, and double-click on the 
=le name. Click OK. 

4e =le will be placed into your document. Sometimes the object that is inserted will be too 
big, so you may need to resize it and then edit it to ensure the correct data is displayed. 

Edit imported data

To edit the object you have imported, double-click on it and you will be in 

editing mode. 

4e tools you have available to edit an object will depend on the program that the object was 
created in. You will generally have a lot of the same functions you had when you created the 
object in the original program.

O0en Excel worksheets will contain a number of rows and columns of data. You may not 
want all the data to be shown in your Word document, so you may need to adjust the range 
of cells that are on display.

Double-click on the Excel object to enter editing mode. You will be presented with a ‘mini’ 
version of Excel complete with the various worksheets and scroll bars for moving through 
the data. 
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To hide any data that you do not want displayed (e.g. blank rows or columns), use the 
cropping handles on the sides and corners to click and drag to adjust the size of the area 
displayed. Below the display area has been adjusted so that the blank rows and columns are 
now hidden. While in editing mode you can also change the data on your spreadsheet.

When you have =nished editing your object, simply double-click anywhere in your 
document outside of the object and the object will once again appear like a graphic. You can 
now resize the object to meet your needs.

Create a mail merge

Mail merges allow you to combine the contents of two 4les, one that contains 

the information you are sending and one that contains details of the recipients. 

Mail merges can be used for personalising letters, reports and 
Iyers. 

4e easiest way to learn about mail merges is to work through 
the process of completing one. 

To create a mail merge, go to Mailings tab, click on Start 
mail merge and then select Step-by-Step Mail Merge 
Wizard. At this point, the Mail Merge task pane will appear 
to the right of the screen. 

Follow each step of the process:

• Step 1: Select the document type – You can choose from 
letters, email messages, envelopes, labels and a directory.

• Step 2: Select starting document – You may use the 
current document, a template or an existing document.

• Step 3: Select recipients – 4e recipients are the people 
who will receive the document. You are given three 
options:

 − Use an existing list – Choose this if you already have a 
recipient list or data source available.

 − Select from Outlook contacts – Choose this if you 
have pro=les set up in Outlook.
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 − Type a new list – Choose this if you have not previously created a data source or 
recipient list. If you choose this option, you can create a recipient list by clicking 
Create. To create a recipient list, you need to set up or customise your columns. To 
do this, click Customize Columns. In the Customize Address List, you can add, 
delete or rename =elds or columns. When entering data, you can either click into 
each =eld using the mouse or use the Tab and Enter keys on the keyboard to jump 
from =eld to =eld.

• Step 4: Write your letter – Select where you want a =eld, then click Insert Merge Field 
from the Mailings tab. Select the =eld you want to insert and repeat for each =eld. 

• Step 5: Preview your letters – Use the forward and backward arrows in the panel to 
preview each letter. When you click an arrow, the document on the le0-hand side should 
be updated with the record.

• Step 6: Complete the merge – 4ere are two options provided to complete the merge: 
Print or Edit individual letters. When saving the document, make sure you save the 
source document with the merge =elds, not the Letters1 document. 4is is important if 
you wish to use the same letter at some stage in the future.

Practice task 10

In this practice task you will complete a mail merge based on the following letter.

25 February 2018

Henderson Printers

PO Box 522

Maroochydore QLD 4558

Dear Alex,

We are in the process of completing a review of our client records 

and credit limits and, due to your purchase and payment history, we 

would like to offer you an increase in your credit limit to $15,000. 

Your current limit is $10,000.

If you are interested in increasing your credit limit, please contact 

us and discuss your preferred credit limit with Ellen, our �nancial 

controller. 

Yours sincerely,

Brett Thomas

Manager
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1. Open a new blank document in Word. 

2. Select the Mailings tab, click on Start Mail Merge then select Step-by-Step Mail Merge 
Wizard. 

3. Select Letters from the task panel and click Next: Starting document. Now you need to 
set up your letters. 

4. Select Use the current document, then click Next: Select recipients. 

5. Select Type a new list, then select Create.

6. Create a recipient list with the following information. Remember to customise your 
address list =rst.

Company 

name
Address City State

Post 

code

First 

name
Surname

Current 

credit limit

Henderson 

Printers

PO Box 

522
Maroochydore Qld 4558 Alex Bolton $10,000

Ingles 

Accounting

28 Melville 

Street
Noosa Qld 4566 Susan McFee $4,000

John Marcus 

& Sons

PO Box 

193
Beerwah Qld 4519 John Marcus $8,000
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7. Type these details into the =elds. To create a new record, click New Entry a0er you have 
entered a record. When you have =nished entering all the details, click OK to save the 
list. Choose an appropriate location for the list =le and an appropriate name for the 
recipient list. Click Save.

8. Ensure all recipients are ticked. Click OK. 4en click Next: Write your letter.

9. Now type and format the following letter, including the de=ned merge =elds. To do this, 
select where you want the =eld, then click Insert Merge Field from the Mailings tab. 
Select the =eld you want to insert and repeat for each =eld. 

25 February 2018

Henderson Printers

PO Box 522

Maroochydore QLD 4558

Dear Alex,

We are in the process of completing a review of our client records 

and credit limits and, due to your purchase and payment history, we 

would like to offer you an increase in your credit limit to $15,000. 

Your current limit is $10,000.

If you are interested in increasing your credit limit, please contact 

us and discuss your preferred credit limit with Ellen, our �nancial 

controller. 

Yours sincerely,

Brett Thomas

Manager
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10. Click Next: Preview your letters. Use the forward and backward arrows in the panel to 
preview each letter. 

11. Click Next: Complete the merge. Click Edit individual letters. Select All and click OK.

12. Select the File tab and choose Save As. Save the =le to an appropriate place on your 
computer or network server.

Edit documents

Once you have drafted a document, the next step is to review and edit it to 

ensure it meets organisational and task requirements. 

You need to check the style and layout of the document and you must also check the 
spelling, grammar and punctuation.

Make sure you allow time for editing and proofreading documents before they are printed, 
published or distributed to colleagues. You may need to complete a =nal check of the style 
and layout speci=cations and look out for spelling and grammatical errors.

Many organisations have a checklist to help people systematically go through the points 
that need to be considered before a document is =nalised. Your organisation may have some 
special requirements that need to be checked as part of the editing process, so make sure 
you are familiar with these. 

Below are some aspects to keep in mind when editing and proofreading documents.

Document type

Ensure you have selected the correct type of document. For example, when asked to 

collect some information, do the results need to be presented in a report or can they go 

into a memo?

Audience, purpose and contents

Is the document you have produced suitable for the audience and purpose? Does it 

need to be formal or informal? Is the language appropriate? Is there too much jargon? Is 

all the required information included? Is it presented in an easy-to-understand format?

Spelling, grammar and punctuation

Be aware that an electronic spelling and grammar checker will not always pick up 

words that are used inappropriately (such as using ‘there’ instead of ‘their’), so it is 

best to also proofread your document. Words may also be spelt in different ways; for 

example, American and Australian spelling for words such as organize/organise. Check 

the in-house style manual. You will need to use your discretion to decide whether the 

suggested option actually is the best (or even correct!) one.

Style

Ensure you have used the correct template, if one is available. Have you followed the 

guidelines in the organisation’s in-house style manual, including use of logos and fonts? 

Is the style consistent? Make sure headers and footers are correct and spacing is 

consistent throughout. Check the in-house style manual. 
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Numerical and statistical data 

Match your document with the original �gures you were given, and check that all data 

and calculations are accurate. It is very easy to make a mistake when entering a lot of 

numerical data into a document.

E
x

a
m

p
le Failing to check work thoroughly

Nancy is an administration assistant working for a supplies 

�rm. She has just �nished typing up the monthly sales 

report. She considers herself very ef�cient, and has 

completed this task regularly for the last six months. She 

sits down and proofreads the report, picking up a couple of 

formatting errors, but is con�dent it is ready to go. She puts 

a copy in the manager’s tray and then proceeds to make 

100 copies to distribute at the sales meeting.

Peter, another employee, comes over to the photocopier 

and picks up a copy of the report while waiting to do his own 

copying. He reads the �rst paragraph and sees that it mentions an increase of 50 per 

cent in new sales, when he is sure the manager’s memo on the subject mentioned an 

increase of only 15 per cent.

After a quick glance at another section of the report, he notices the name of a valued 

client, ‘Paula Mart’ has been mistyped and reads ‘Paula Nart’. Peter approaches Nancy 

regarding the errors and suggests that the report needs further proofreading. Nancy is 

shocked and says she will re-read the report right away and correct any errors.

Practice task 11

Work through the following task to practise importing and editing an Excel worksheet.

1. Access and download client-fees.xlsx at: http://chilp.it/d68ee79. 

2. Import this Excel =le into a blank Word document.

3. Resize the object so that it takes the full width of the page.

4. Save and print your work.
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When you are assigned a task in the workplace it is important that you clarify 

when it needs to be completed by. 

A time line sets the schedule for a task or project. It gives details of each task that needs to 
be completed to achieve the =nal goal and describes who will complete each task and how 
long they have to do this. 

Time lines

Time lines may be set by other people in your organisation, or you may need to 

develop your own based on your task requirements and deadlines. 

A time line is a plan for how long a task will take to 
complete. To successfully meet these requirements, 
you need to de=ne the scope of the document. To 
do this, you need to clarify who the audience is and 
exactly what the document is meant to say. 4en you 
need to identify the tasks involved in producing the 
document. Next, work out how long it will take you 
to complete each task. By completing each task in 
the time you have allocated, you should be able to 
produce the document on time.

When developing a time line, you may need to factor 
in a number of things that are beyond your control, 
such as:

• waiting to receive information from several team members to be collated into one 
document

• ensuring that resources, staA and equipment needed to produce a document are 
available and are not in use by another department.

In many cases, time lines are set and agreed with your stakeholders – both internal and 
external. Internal stakeholders are those that work at the same organisation as you, and may 
include colleagues in other departments, managers and supervisors. External stakeholders 
are those that are outside the organisation, including customers and suppliers. 

O0en your manager or supervisor will give you a deadline for completing a task (e.g. 
prepare a dra0 letter by 2pm). Alternatively, you may have deadlines for completing regular 
work tasks, e.g. completing a monthly sales report or sending letters to customers who are 
overdue in paying an invoice by a certain number of days. 

Meeting a deadline demonstrates your competency and your professionalism in 
undertaking tasks. Make sure that when deadlines are being set, they are both achievable 
and realistic.

If you have concerns that a deadline might not be met or you have conIicting work 
priorities, discuss this with your manager or supervisor as soon as possible. 4ey may be 
able to assist you by suggesting how the deadline can be met or agreeing to adjust the time 
line for the task.

3C Meet time lines and overcome problems 
with document production
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Tasks you may need to include in your time line:

 • Clarifying the document’s scope and audience

 • Researching the proposed content of the document

 • Accessing relevant information to include in the document

 • Writing the document

 • Formatting the document

 • Checking/proofreading the document

 • Incorporating feedback on the document

 • Printing and distributing the document

Practice task 12

Read the case study, then answer the questions that follow.

Case study
Karen works as an administrative assistant. She has been asked to produce the organisation’s 

newsletter. This is usually delivered in hard copy to internal and external clients.

The newsletter includes reports from a number of people in different departments. It also includes 

photographs and a report that must be written by Karen about the progress of a current project.

Karen makes a list of everyone who has to submit work for the newsletter. She informs each person 

about the work they need to submit and when it is required. She asks a colleague to take the 

necessary photos and have them ready one week before the release of the newsletter. Karen then 

has to write her report.

After that, she plans all of the tasks that still need to be done. She has to talk to colleagues involved 

in the project, draft and edit her report and collect reports and photos from colleagues.

Question 1 

Explain why the newsletter needs a time line.
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Question 2 

Comment on Karen’s planning. What do you think was good or bad about her planning?

Question 3 

When a number of people are involved in the production of a document, what can go wrong?

Overcoming formatting issues

You will often experience di9culties when designing or producing documents. 

4e hardware you are using might fail or the so0ware might crash. Whatever the problem, it 
helps to have a plan for dealing with the unexpected. Organisations deal with di�culties in 
a number of diAerent ways; some might have manuals or training notes, others might have a 
help desk set up to aid employees.

Tasks that you may need help with include:

• formatting text

• adjusting the size of margins

• inserting pictures, graphs and charts

• formatting tables

• adjusting print settings

• inserting columns and section breaks.

You can ask for help at any time by typing in details in the search bar at the top of the 
ribbon. 

You can also press F1 on the keyboard to access the help facility. 
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Other sources of help for solving problems with word-processing so0ware include:

• referring to manuals and training booklets in your workplace

• accessing websites that oAer advice on so0ware use

• asking colleagues for help and advice

• participating in training courses.

Help with using tool buttons

Each time you move the pointer over a tool button, it will display a bubble that 

tells you what the button is used for. 

For instance, from the Home tab, move the pointer over the font tools and you will notice 
the bubble for the Change Case tool button as follows:
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Help manuals and training materials

Word-processing software comes with user manuals that describe the 

software’s features and provide step-by-step instructions for carrying out 

di"erent functions. 

You can =nd manuals in either print or electronic formats. 

4ere are many websites where you can =nd information about Microso0 O�ce 
applications. 4ese contain solutions to common problems and frequently asked questions. 
You can also download updates, tools and any =xes Microso0 has developed for so0ware 
problems. You may =nd the following sites useful.

http://aspirelr.link/microsoft-support

This is Microsoft’s main site for �nding help to solve problems for all Microsoft products. 

You can ask questions online and download �les, including service packs, drivers and 

patches. 

http://aspirelr.link/microsoft-of�ce

This site provides resources for all Microsoft Of�ce applications. It has news and 

announcements, as well as useful �les that you can download. If you are connected to 

the internet, you can open this site by selecting Help in any Of�ce application. You may 

need to click on the bottom right of the window to allow access to Of�ce.com.

Another resource you can refer to is training material. Training courses usually provide a 
comprehensive set of instructions or notes that are worth keeping for future reference.

You may have been to a training course to learn a particular computer function or a supplier 
may have instructed you on how to use a piece of equipment. You may have received 
training or induction materials during your induction. 

You may need to refer back to your training notes whenever you need help with a speci=c 
program or function.

Interpreting error messages

Many word-processing software users struggle when faced with an error 

message that includes information they do not understand. 

Here is a common error message. 4is error is o0en encountered when you have created a 
document with the paper size set to Letter and then attempt to change the paper size to A4 
before printing.
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If you read the error carefully you can identify the settings you need to check to =x the 
problem. For example, you may need to adjust margins, column spacing or paragraph 
indents. By checking each of the settings and adjusting them as required, you should be able 
to =x the problem.

If you are unable to understand a message, you could search the internet for help. You can 
search on the Microso0 O�ce support sites or you can perform a general search using a 
search engine. Alternatively, you may decide to take a screenshot and send it to a colleague 
or the IT helpdesk for assistance.

Taking screenshots

It can be helpful to take a screenshot to communicate the issue you are having 

to someone else. 

A screenshot captures the image of your computer screen in its current state, including 
any error messages that are being displayed. If you are having a particular issue with your 
computer that is di�cult to describe, it can be useful to take a screenshot and send this 
image in an email to the IT department or a colleague who may be able to assist.

To take a screenshot, press the print screen icon on your keyboard (this may be displayed 
as an abbreviation, such as ‘PrtScn’). 4en insert the image into an email by pressing 
Ctrl+V on the keyboard or by right-clicking the mouse and selecting Paste from the drop-
down menu.

If you are using two screens, the image will show both of your screens. You may need to 
crop part of the image to focus on the issue you are having, such as an error message. To do 
this, click on the image and under the Format tab, select Crop. 4en you can drag the edges 
of the image in to focus on the issue.

Practice task 13

Read the case study, then answer the questions that follow.

Case study
Damir is a personal assistant to the manager of a large organisation. One of his duties is to produce 

business documents using a variety of software applications. Damir often needs to use the Help 

function to assist him with formatting documents.

Sometimes Damir experiences software function problems that cannot be solved using the Help 

function, so he uses Microsoft’s support website to �nd solutions. There is a manual available and 

he keeps an electronic copy in a Help folder on his desktop.
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Question 1 

Damir sometimes has a software functionality problem. Where does he go for help?

Question 2 

What should Damir do if he is unsure what a particular icon does?

Question 3 

Describe how Damir stores help manuals.

Question 4 

Do you ever experience software problems while producing a document? Describe the steps you 

usually take to solve the problem.
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An important task when creating documents is saving your work. 

Saving the document ensures that you can edit or 
print it again when required. Each organisation 
has its own policies regarding naming and storing 
documents and it is important you follow these 
procedures so that you and other staA can access the 
documents as required.

You need to be careful when exiting your work and 
closing the document so there is no information loss 
or damage. 

Most documents you create will be stored 
electronically. Occasionally hard copies (printouts) 
of the documents may be stored in the organisation’s 
paper-based =ling system.

Electronic 1le storage

Your organisation is likely to have an established system for naming electronic 

4les to ensure all employees are able to 4nd 4les when they are required.

Each organisation uses folder structures and naming standards to ensure that =les are easy 
to identify and locate. If your organisation has a network, you may have shared directories 
and folders that several staA have access to. 

It is important that you check your =les and delete any that are no longer required on a 
regular basis to ensure the system remains e�cient. If you are planning to have a clean-up 
of your =les, check with your supervisor before you delete any; in particular, check which 
projects or clients you need to keep =les for. You should never delete or move =les created by 
another employee without their permission.

Organisations usually perform regular backups of shared directories and folders. In larger 
organisations, a staA member from the IT department will usually be responsible for this. If 
you are planning to delete a lot of =les, it may be a good idea to perform a backup of the =les 
(which can be kept before deleting them).

Advantages of using shared directories and naming standards

 • Files are easy to �nd. 

 • A document can be accessed by multiple employees, and can be completed in an 

employee’s absence.

 • Work is less likely to be duplicated as staff can check to see if a document has 

already been created.

 • Files stored in shared directories are normally backed up on a regular basis.

 • Shared directories can have different permissions set, such as read-only.

 • Virus scans are normally run on shared folders on a regular basis.

3D Save and print documents
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Folder structure

Folders generally have a treelike structure that branches from a parent 

directory to sub-folders in a hierarchical structure.

In the following example, the server has three folders for three separate workgroups: 

• Group A

• Group B 

• Group C

Group C has three major folders: 

• Procedures

• Personnel 

• Projects

4e Projects Folder has three folders: 

• Project A

• Project B 

• Project C

4e Project C folder has two documents: 

• ProjectC_timelines.docx 

• ProjectC_research1.docx

4e =le path for retrieving a document starts at the server and ends when the correct 
document is located. For example, to reach the ProjectC_timelines.doc the =le path is:  
C:\GroupC\Projects\ProjectC\ProjectC_timelines.docx.

SERVER (C DRIVE)

Group A

Project A

ProjectC_timelines.docx

Procedures

Group B

Project B

ProjectC_research1.docx

Personnel

Group C

Project C

Projects
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Practice task 14

Part A
Look at the following folder structure. Imagine that you belong to Group C.

SERVER (C DRIVE)

Group A

Project A

ProjectC_timelines.docx

Procedures

Group B

Project B

ProjectC_research1.docx

Personnel

Group C

Project C

Projects

Question 1 

You want to add another time line document for Project A to your shared directory. Write out the 

�le path you would use to place it in the correct location. Decide on an appropriate name for the 

document.

Question 2 

Describe four advantages of using a shared directory.
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Part B
Read the case study, then answer the questions that follow.

Case study 
Fred has retired from an organisation after working as an administrative assistant for 10 years. 

The areas Fred was responsible for were accounts and projects. The day after he retired, someone 

needed a �le that Fred had created and stored. The �le contained vital accounting information. It 

was discovered that Fred had saved more than 500 �les in a variety of folders and the �le could not 

be located. The folders had ambiguous names such as Folder1 and Folder2 and the �les had names 

such as august1.docx and march2.docx.

Question 1 

Describe why Fred’s folder and �le naming system failed.

Question 2 

Fred was responsible for two areas. What could he have done to make sure �les could be easily 

located?

Question 3 

Explain why folder and �le names should be consistent, simple and meaningful.
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Print documents

There is a range of options available when printing documents. 

Print preview allows you to view a document as it will appear when printed.

To view print preview, select the File tab and click Print. 4e print preview will be shown in 
the right panel. You can use the zoom bar to zoom in or out on your page, or to view several 
pages at once.

Once you are happy with the =nal version, you can select Print.

Hard-copy storage

Many documents stored digitally are also stored in hard copy as a safeguard 

against a computer system failure. 

Hard-copy storage requires physical space. It also requires a =ling system that uses 
consistent, simple and meaningful names similar to those used in digital storage.

Managing hard-copy documents is necessary to e�ciently use storage space. Retention 
schedules are used to determine which documents need to be kept and for how long. 
Documents without permanent value may be scheduled for eventual destruction. However, 
be aware that some documents need to be retained for legal reasons; for example, taxation 
details need to be retained for at least six years.
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4e following is an example of a retention schedule.

Retention schedules for hard-copy documents

Credit card receipts and statements 2 years

Tax records 6 years

Accounts records 6 years

Invoices 1 year

Client correspondence 2 years

Unsolicited CVs 6 months

Network/operating system logons

Passwords are commonly used in organisations to ensure that only authorised 

users are able to access 4les.

Most organisations have networks made up of more than one computer. Before employees 
can use a computer that is connected to the network, they must be issued a logon username 
and password, which identi=es them and allows them to access the =les on the network. 

Employees can be given access to shared drives and directories or to individual =les and 
folders.

You should change your password on a regular basis and ensure you do not tell anyone what 
it is. Your password should not be anything that can be easily guessed by other people, such 
as your date of birth, name, or names of family members and pets. Good passwords contain 
a mixture of letters and numbers and are six to eight characters long. 

Depending on the network con=guration, you are likely to have a personal drive for your 
=les along with access to various shared drives. Where information contained in =les is 
sensitive and not to be viewed by all employees, you can save it on your personal drive or 
apply a password to protect an individual =le. Two levels of access can be applied:

• a password to open the =le, which allows the =le to be viewed or printed

• a password to modify the =le, which will let the user make changes to the =le.

You can let any other person who needs to access the =le know the password.

To apply a password to a Word =le, select the File tab and click Protect Document, and 
choose one of the options from the drop-down menu. 



102
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU313
Design and produce digital text documents

Select how you wish to apply restrictions, then click Yes, Start Enforcing Protection.

A pop-up box will appear where you enter and re-enter a password. Click Save.

Prevent data loss

After creating or modifying an electronic document, you need to exit the 

software application without causing damage or loss of data. 

Data loss can occur when a computer program stops performing its expected function. Often the 

program, or even the whole computer, may appear to freeze. You may experience data loss and 

may be unable to access data. Data may have been accidentally erased or corrupted and made 

inaccessible. 

The main cause of data loss is human error. Below are a number of precautions you can use to 

prevent data loss. 

Work on one document at a time

Try to work on only one document at a time. If you need to work with multiple 

applications open, you should close applications when they are no longer needed. 

This will help your computer work more ef�ciently and will help to prevent computer 

failure.



Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

103

Topic 3
Produce digital text documents

Lock unattended workstations

Data loss can occur if someone else tampers with your work. If you are working on 

a document, ensure you lock your computer or exit the application before leaving 

your workstation.

Use virus protection 

Other causes of data loss include damage from viruses, operating system or 

application software bugs and failed upgrades. Using virus protection programs 

and frequently updating software can help to prevent data loss.

Prevent computer malfunction

If your computer starts to make unusual noises or display warning messages, save 

your work, then shut down the computer immediately and do not turn it back on 

until you have received advice from an IT coordinator.

Use the correct exit procedure

Before shutting down your computer, exit all programs by selecting the exit button, 

which is generally located in the top right corner of the window. Ensure you save 

your work �rst. If you have recently made changes to your document, you will 

usually be prompted to save before exiting.

Practice task 15

Read the case study, then complete the question that follows.

Case study
Leigh works as an of�ce administrator for a large organisation. Her daily tasks include modifying 

documents in a variety of software applications. One day she had to modify three documents in 

three different applications.

Leigh opened all three �les before starting work. While working on one document, she went on 

coffee break, leaving all three applications open. When Leigh returned, she found that her computer 

was slower than usual and then it started to make unusual noises. Soon after, Leigh’s monitor went 

blank.

Describe the mistakes Leigh made when modifying her documents.



104
Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

BSBITU313
Design and produce digital text documents

Summary

• Use advanced so0ware functions to produce documents e�ciently.

• Import text and data from other documents and so0ware applications to save time.

• Editing ensures that the document is grammatically correct, has an eAective design and 
meets organisational requirements.

• A checklist is o0en used to help people systematically go through all the points that 
need to be considered when editing a document.

• A time line sets the schedule for a task or project. It gives details of each task that needs 
to be accomplished to achieve goals.

• Use online and paper-based manuals and other training materials to overcome 
problems with document design and production.

• Most organisations have folder structures and naming standards. 4is allows users to 
set up folders quickly and easily.

• Hard-copy documents need to be kept and archived, or destroyed a0er the appropriate 
period of time.

• Make sure you exit applications without causing damage or data loss.
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Learning checkpoint 3 
Produce digital text documents

Part A
You work for Plant Paradise. 4e business does not currently have any templates and you 
have been given the following tasks to complete.

1. Design a template for a promotional Iyer with the following details.

Plant Paradise

124 Sunhill Street, BUDERIM QLD 4556

Ph: 07 5423 9912

Email: inquiries@plantparadise.com.au

Website: www.plantparadise.com.au

2. Use a suitable image as part of the header.

3. Ensure the paper size is A4 and set the top and bottom margins to 1cm and the le0 and 
right margins to 2cm.

4. Save the template as ‘Plant-Paradise-Iyer’.

Part B
Read the case study, then complete the task that follows.

Case study
You work for Johnson’s Motors, a car dealership that sells and services Toyota and Suzuki vehicles. A 

new computer system has just been installed and you have been asked to create a folder structure 

that will meet their needs. It is important that they keep the information for Toyotas and Suzukis 

separate. They need to store the following information for each make of vehicle:

 • Sales

 • Servicing

 • Marketing

You also need to store electronic �les on employees, advertised positions and accounting data.

Design a folder structure to suit Johnson’s Motors. Make sure you choose names that are 
consistent, simple and meaningful.
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Part C
Below are some sample error messages for O�ce 365 or Word 2016. 

Research using the internet to provide a brief explanation of what each error message means 
and what can be done to =x it.

a) 

b) 
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